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Package Contents

Contents of Package:

D-Link AirPlus XTREME G DI-624
High-Speed 2.4GHz Wireless Router

Power Adapter-DC 5V, 3.0A

Manual and Warranty on CD

Quick Installation Guide

Ethernet Cable (All the DI-624’s Ethernet ports are Auto-MDIX)

Note: Using a power supply with a different voltage rating than the one included with the
DI-624 will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

System Requirements for Configuration:

Ethernet-Based Cable or DSL Modem

Computers with Windows, Macintosh, or Linux-based
operating systems with an installed Ethernet adapter

Internet Explorer Version 6.0 or Netscape Navigator
Version 6.0 and Above



Introduction

The D-Link AirPlus Xtreme G DI-624 High-Speed Wireless Router is an 802.11g high-
performance, wireless router that supports high-speed wireless networking at home, at
work or in public places.

Unlike most routers, the DI-624 provides data transfers at up to 108 Mbps (compared to
the standard 54 Mbps) when used with other D-Link AirPlus Xtreme G products. The
802.11g standard is backwards compatible with 802.11b products. This means that you
do not need to change your entire network to maintain connectivity. You may sacrifice
some of 802.11g’s speed when you mix 802.11b and 802.11g devices, but you will not
lose the ability to communicate when you incorporate the 802.11g standard into your
802.11b network. You may choose to slowly change your network by gradually replacing
the 802.11b devices with 802.11g devices .

In addition to offering faster data transfer speeds when used with other 802.11g products,
the DI-624 has the newest, strongest, most advanced security features available today.
When used with other 802.11g WPA (WiFi Protected Access) and 802.1x compatible
products in a network with a RADIUS server, the security features include:

WPA: Wi-Fi Protected Access authorizes and identifies users based on a secret key
that changes automatically at a regular interval. WPA uses TKIP (Temporal
Key Integrity Protocol) to change the temporal key every 10,000 packets (a
packet is a kind of message transmitted over a network.) This insures much
greater security than the standard WEP security. (By contrast, the older WEP
encryption required the keys to be changed manually.)

802.1x: Authentication is a first line of defense against intrusion. In the Authentication
process the server verifies the identity of the client attempting to connect to the
network. Unfamiliar clients would be denied access.

For home users that will not incorporate a RADIUS server in their network, the security
for the DI-624, used in conjunction with other 802.11g products, will still be much stronger
than ever before. Utilizing the Pre Shared Key mode of WPA, the DI-624 will obtain a
new security key every time it connects to the 802.11g network. You only need to input
your encryption information once in the configuration menu. No longer will you have to
manually input a new WEP key frequently to ensure security, with the DI-624, you will
automatically receive a new key every time you connect, vastly increasing the safety of
your communications.



Connections

All Ethernet Ports (WAN and LAN)
are auto MDI/MDIX, meaning you can
use either a straight-through or a
crossover Ethernet cable.

Pressing the
Reset Button
restores the
router to its
original factory
default settings.

Auto MDI/MDIX

The Auto MDI/ Receptor
L‘;N L MDIX WAN portis | | forthe
automatically sense the connection for Power

the cable type when
connecting to
Ethernet-enabled
computers.

the Ethernet cable Adapter
to the Cable or
DSL modem




LEDs

WAN LED

A solid light indi-
cates connection
on the WAN port.
This LED blinks
during data trans-

WLAN LED

A solid light
indicates that the
wireless segment
is ready. This LED

mission.

blinks during

wireless data
transmission.

POWER LED

A solid light
indicates a proper
connection to the
power supply.

LOCAL
NETWORK LED

A solid light indicates
a connection to an
Ethernet-enabled

STATUS

A blinking light
indicates that the
DI-624 is ready.

computer on ports 1-
4. This LED blinks
during data trans-
mission.




Features

Fully compatible with the 802.11g standard to provide a wireless data rate of
up to 108Mbps

Backwards compatible with the 802.11b standard to provide a wireless data
rate of up to 11Mbps

WPA (Wi Fi Protected Access) authorizes and identifies users based on a
secret key that changes automatically at a regular interval, for example:

B TKIP (Temporal Key Integrity Protocol), in conjunction with a RADIUS
server, changes the temporal key every 10,000 packets, ensuring greater
security

B Pre Shared Key mode means that the home user, without a RADIUS
server, will obtain a new security key every time the he or she connects
to the network, vastly improving the safety of communications on the
network

802.1x Authentication in conjunction with the RADIUS server verifies the
identity of would be clients

Utilizes OFDM technology (Orthogonal Frequency Division Multiplexing)

User-friendly configuration and diagnostic utilities

Operates in the 2.4GHz frequency range

Connects multiple computers to a Broadband (Cable or DSL) modem to
share the Internet connection

Advanced Firewall features

B Supports NAT with VPN pass-through, providing added security
B MAC Filtering

M IP Filtering

B URL Filtering

W Domain Blocking
H Scheduling

DHCP server enables all networked computers to automatically receive IP
addresses

Web-based interface for Managing and Configuring

Access Control to manage users on the network

Supports special applications that require multiple connections

Equipped with 4 10/100 Ethernet ports, 1 WAN port, Auto MDI/MDIX



Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use and
compatible high-speed wireless connectivity within your home, business or public access
wireless networks. D-Link wireless products will allow you access to the data you want,
when and where you want it. You will be able to enjoy the freedom that wireless networking
brings.

A WLAN is a cellular computer network that transmits and receives data with radio
signals instead of wires. WLANs are used increasingly in both home and office
environments, and public areas such as airports, coffee shops and universities. Innovative
ways to utilize WLAN technology are helping people to work and communicate more
efficiently. Increased mobility and the absence of cabling and other fixed infrastructure
have proven to be beneficial for many users.

Wireless users can use the same applications they use on a wired network. Wireless
adapter cards used on laptop and desktop systems support the same protocols as
Ethernet adapter cards.

People use wireless LAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location
within the operating range of the WLAN. Management decisions based on real-time
information can significantly improve worker efficiency.

Low Implementation Costs — WLANSs are easy to set up, manage, change and
relocate. Networks that frequently change can benefit from WLANs ease of
implementation. WLANs can operate in locations where installation of wiring may be
impractical.

Installation and Network Expansion - Installing a WLAN system can be fast
and easy and can eliminate the need to pull cable through walls and ceilings. Wireless
technology allows the network to go where wires cannot go - even outside the home or
office.

Scalability — WLANs can be configured in a variety of topologies to meet the needs of
specific applications and installations. Configurations are easily changed and range
from peer-to-peer networks suitable for a small number of users to larger infrastructure
networks to accommodate hundreds or thousands of users, depending on the number
of wireless devices deployed.

Inexpensive Solution - Wireless network devices are as competitively priced as
conventional Ethernet network devices.



Wireless Basics (continued)

Standards-Based Technology

The DI-624 Wireless Broadband Router utilizes the new 802.11g standard.

The IEEE 802.119g standard is an extension of the 802.11b standard. It increases the
data rate up to 54Mbps within the 2.4GHz band, utilizing OFDM technology.

This means that in most environments, within the specified range of this device, you will
be able to transfer large files quickly or even watch a movie in MPEG format over your
network without noticeable delays. This technology works by transmitting high-speed
digital data over a radio wave utilizing OFDM (Orthogonal Frequency Division Multiplexing)
technology. OFDM works by splitting the radio signal into multiple smaller sub-signals
that are then transmitted simultaneously at different frequencies to the receiver. OFDM
reduces the amount of crosstalk (interference) in signal transmissions.

The DI-624 is backwards compatible with 802.11b devices. This means that if you have
an existing 802.11b network, the devices in that network will be compatible with 802.11g

devices at speeds of up to 11Mbps in the 2.4GHz range.



Wireless Basics (continued)

Installation Considerations

The D-Link AirPlus Xtreme G DI-624 lets you access your network, using a wireless
connection, from virtually anywhere within its operating range. Keep in mind, however,
that the number, thickness and location of walls, ceilings, or other objects that the
wireless signals must pass through, may limit the range. Typical ranges vary depending
on the types of materials and background RF (radio frequency) noise in your home or
business. The key to maximizing wireless range is to follow these basic guidelines:

1 Keep the number of walls and ceilings between the DI-624 and other network
devices to a minimum - each wall or ceiling can reduce your D-Link wireless
product’s range from 3-90 feet (1-30 meters.) Position your devices so that
the number of walls or ceilings is minimized.

2 Be aware of the direct line between network devices. A wall that is 1.5 feet
thick (.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter)
thick. At a 2-degree angle it looks over 42 feet (14 meters) thick! Position
devices so that the signal will travel straight through a wall or ceiling (instead
of at an angle) for better reception.

3 Building Materials can impede the wireless signal - a solid metal door or
aluminum studs may have a negative effect on range. Try to position wireless
devices and computers with wireless adapters so that the signal passes
through drywall or open doorways and not other materials.

4. Keep your product away (at least 3-6 feet or 1-2 meters) from electrical
devices or appliances that generate extreme RF noise.

10



Getting Started
2)

Cable/DSL Modem

Internet

DI-624

Speed 2.4GHz

High-
\ Wireless Broadband Router

Computer 3 @

Desktop PC or Laptop
(Wireless Adapter Required)

esktop PC or Laptop

» Computer 2 @

Desktop PC or

(Wireless Ada

quired)

Please remember that D-Link AirPlus Xtreme G wireless devices are pre-configured
to connect together, right out of the box, with their default settings.

For a typical wireless setup at home (as shown above),
please do the following:

o You will need broadband Internet access (a Cable or DSL-subscriber line into
your home or office).

9 Consult with your Cable or DSL provider for proper installation of the modem.

Connect the Cable or DSL modem to the DI-624 Wireless Broadband Router
(see the printed Quick Installation Guide included with your router.)

If you are connecting a desktop computer to your network, install the D-Link
AirPlus Xtreme G DWL-G520 wireless PCl adapter into an available PCI slot on
your desktop computer. You may also install the DWL-520+, or the DWL-520.
(See the printed Quick Installation Guide included with the network adapter.)

6 Install the D-Link DWL-G650 wireless Cardbus adapter into a laptop computer.
(See the printed Quick Installation Guide included with the DWL-G650.)

= Install the D-Link DFE-530TX+ adapter into a desktop computer. The four
Ethernet LAN ports of the DI-624 are Auto MDI/MDIX and will work with both
Straight-Through and Cross-Over cable.
(See the printed Quick Installation Guide included with the DFE-530TX+.) 11



Using the Configuration Menu

Whenever you want to configure your network or the

DI-624, you can access the Configuration Menu by T e e
opening the web-browser and typing in the IP Address 3
of the DI-624. The DI-624 default IP Address is shown Qe - O xiLl nELI wl |

at right: addvess [ @] http://192.168.0.1
] Open the web browser
] Type in the IP Address of
the Router (http://192.168.0.1)

Connect to 192.168.0.1

'ﬁ'ﬂ.l A

Note: if you have changed the default IP Address assigned
to the DI-624, make sure to enter the correct IP Address. prar
[ | Type admin in the User ;wd :ﬁ e :
Name field DRemember my passward
| Leave the Password blank
m Click OK

Home > Wizard
D-Link —AmrPlus i

Building Networks for People MWWE
High-Speed 2.4GHz Wireless Router

The Home>Wizard
screen will appear.
Please refer to the
Quick Installation

Home Advanced . Tools Status_ Hel

Setup Wizard

The DI624 is a Wireless Broadhand Router ideal for home networking and small
husiness networking. The setup wizard will guide you to configure the DI-624 to

Gui(_je for more infor- pra— you 1 v Inkprmet oozess withn rakudss. Piease fullw the seusp wisard sefi
matlon regardlng the by step to configure the DI-624.
Setup Wizard. -
Run Wizard
N 1+
Help
|
These buttons appear a Clicking Apply will save changes made to the page.
on most of the configu- Apply
ration screens in this
section. Please click on ‘3 Clicking Cancel will clear changes made to the page.
the appropriate button Cancel
at the bottom of each
screen after you have o Clicking Help will bring up helpful information regarding the page.
made a configuration Help
change.

@ Clicking Restart will restart the router. (Necessary for some changes.)
Restart

12



Using the Configuration Menu (continued)

SSID-

Channel-

WEP-

WEP Encryption-
Key Type-

Keys 1-4-

Home > Wireless

P - . —— -
Lolles AirRlus G-
EME,
High-Speed 2.4GHz Wireless Router
DI-624 I
.7 - Advanced  Tools Status Help
“‘ Wireless Settings
These are the wireless settings for the AP(Access Point)Portion
SEID : |default
Channel - |B ¥
Wireless WEP . € Enabled @ Disabled
WEP Encryption : |64Bit =
" WAN Key Type: [HEX =
Keyl: & |UEIEIUUEIUUEIU
I LAN Key2: |DDDUDDUDDU
Key3: |DDDDDDDDDD
Keyd : ¢ |0000000000
™ bHep bt )
@ 90
Apply Cancel Help

Service Set Identifier (SSID) is the name designated for a spe-
cific wireless local area network (WLAN). The SSID’s factory
default setting is default. The SSID can be easily changed to
connect to an existing wireless network or to establish a new
wireless network.

6 is the default channel. All devices on the network must share
the same channel. (Note: The wireless adapters will automati-
cally scan and match the wireless setting.)

Wired Equivalent Privacy (WEP) is a wireless security protocol
for Wireless Local Area Networks (WLAN). WEP provides secu-
rity by encrypting the data that is sent over the WLAN. Select
Enabled or Disabled. Disabled is the default setting. (Note: If
you enable encryption on the DI-624 make sure to also enable
encryption on all the wireless clients or wireless connection will
not be established.)

Select the level of encryption desired: 64-bit, or 128-bit.
Select HEX or ASCII.

Input up to 4 WEP keys; select the one you wish to use.

13



Using the Configuration Menu (continued)

Dynamic
IP Address-

Host Name-

MAC Address-

Clone
MAC Address-

Primary/
Secondary DNS
Address-

MTU-

Home > WAN > Dynamic IP Address

-
- - — -
D:Link AiPlus _—~-
= 4
High-Speed 2.4GHz Wireless Router
DI-624 l
LCT I Advanced  Tools Status Help
Please select the appropriate option to connect to your [SP.
Wizard

& Dynamic IP Address Choose thiz option to obtain an IP address automatically

from your ISP. (For most Cable modem users)
MWireless € Static IP Address Chaose this option 1o set statis I information provided ta

you by your ISP,

© PPPOE Chanse this option if your ISP uses PPPAE. (For most
DSL ugers)

WAN € Others PPTP and BigPand Cable
« PPTP (for Europe uge only)
Host Name [DrE24 {optional)
DHCP MAC Address (TR R - A
a6 (optional) Clone MAC Addrass
2 00
Apply Cancel Help

Choose Dynamic IP Address to obtain IP Address information
automatically from your ISP. Select this option if your ISP does
not give you any IP numbers to use. This option is commonly
used for Cable modem services.

The Host Name is optional but may be required by some ISPs.
The default host name is the device name of the Router and may
be changed.

The default MAC Address is set to the WAN’s physical inter-
face MAC address on the Broadband Router. It is not recom-
mended that you change the default MAC address unless re-
quired by your ISP.

The default MAC address is set to the WAN’s physical interface
MAC address on the Broadband Router. You can use the “Clone
MAC Address” button to copy the MAC address of the Ethernet
Card installed by your ISP and replace the WAN MAC address
with the MAC address of the router. It is not recommended that
you change the default MAC address unless required by your
ISP.

Enter a DNS Address if you do not wish to use the one
provided by your ISP.

Enter an MTU value only if required by your ISP. Otherwise, leave
it at the default setting. 14



Using the Configuration Menu (continued)

Static IP Address-

IP Address-

Subnet Mask-

ISP
Gateway Address-

Primary
DNS Address-

Secondary
DNS Address-

MTU-

Home > WAN > Static IP Address

D-Link irP
“LIx —
R s e Al e~
High-Speed 2.4GHz Wireless Router
Dl-624 | —
(1 0 Advanced  Tools Status Help
Please select the appropriate option to connect to your ISP,
[re—
O Dynamic IP Address Choose this option to obtain an [P address automatically
from your ISP. (For most Cable modem users)
—_— @ Static IP Address Choose this option to set static P information provided to
Wireless you by your ISP
O PPPoE Choose this option if your ISP uses PPPoE. (For most
DSL users)
WAN © Others PPTF and BigPand Cable
O PPTP (for Europe use only)
L
" LAN
IP Address |n0.00g| | (assigned hy your ISF)
Subnet Mask looon
DHCP T
ISP Gateway Address EEIEIEIEI
Primary DNS Address |nooo
Secondary DNS Address 0000 {optional)
Apply Cancel Help

Choose Static IP Address if all WAN IP information is provided to
you by your ISP. You will need to enter in the IP address, subnet
mask, gateway address, and DNS address(es) provided to you
by your ISP. Each IP address entered in the fields must be in the
appropriate IP form, which are four octets separated by a dot
(x.x.x.x). The Router will not accept the IP address if it is not in
this format.

Input the public IP Address provided by your ISP.

Input your Subnet mask. (All devices in the network must have
the same subnet mask.)

Input the public IP address of the ISP to which you are
connecting.

Input the primary DNS (Domain Name Server) IP address
provided by your ISP.

This is optional.

Enter an MTU value only if required by your ISP. Otherwise, leave
it at the default setting. 15



Using the Configuration Menu (continued)

Home > WAN > PPPoE

Please be sure to

remove any =N = . — -
existing ml?hg u!‘w!ulr}hl& "AI%E e
SP g,f;iec”e”t High-Speed 2.4GHz Wireless Router

. DI-624 - .

mstallelfi on your . | BT Advanced EPTE Status Help

computers. . NAN Setting:

Pleaze select the appropriate option to connect to your ISP,
———
Choose PPPoE (Point B B s o gy o
tO POInt PI'OtOCO/ over O Static [P Address Choose this option to set static IP information provided to
. " Wireless you by your ISP
Ethernet) If your ISP & PPPoE Chonose this option if your ISP uses PPPoE. (For most
- DSL users)
uses a PPPOE Con E ) Others PPTP and BigPond Cable
nection. Your ISP will o {or Eurpe vroniy)
provide you with a
LAN
username and pass- @® Dynamic PPPoE O Static PPPoE
word. This option is User Name |
typically used for DSL Passward [ 1
services. Select Dy- Retype Passward |
namic PPPoE to ob- Service Name _ _ | (optional
tain an IP address au- e |
tomatically for your e ] _
PPPoE connection. e O A e TR F!
Select Static PPPoE G ==
3 MTU 1432 |

to use a Statlc ,P ad- Auto-reconnect @ Enabled O Disahled
dress for your PPPoE 9 OO0
connection. Apply Cancel Help
PPPoE- Choose this option if your ISP uses PPPoE. (Most DSL users

will select this option.)
Dynamic PPPoE-receive an IP Address automatically from your ISP.
Static PPPoE-you have an assigned (static) IP Address.

User Name- Your PPPoE username provided by your ISP.

Retype Password- Re-enterthe PPPoE password

Service Name- Enter the Service Name provided by your ISP (optional).

IP Address- This option is only available for Static PPPoE. Enter the static IP
Address for the PPPoE connection.

Primary DNS Primary DNS IP address provided by our ISP

Address-

Secondary DNS This option is only available for Static PPPoE. Enter the static IP
Address- Address for the PPPoE connection.

(Continued on the next page) 16



Using the Configuration Menu (continued)

Home > WAN > PPPoE continued

MTU-

Auto-reconnect-

Maximum Transmission Unit-1492 is the default setting-you may
need to change the MTU for optimal performance with your
specific ISP.

If enabled, the DI-624 will automatically connect to your ISP af-
ter your system is restarted or if the PPPoE connection is dropped.

Home > LAN

D-Link

Building Networks for People

“AirrPlus e
Xrrene,
High-Speed 2.4GHz Wireless Router

DI-624 |

LGLL N Advanced  Tools Status Help
" = LAN Settings
The IP address of the DIHB24.
IP Address 192.168.0.1
m Subnet Mask [255.255.2595.0
Local Domain Name I (optional)
—— 00

il Apply Cancel Help

Bk

DHCP

LAN is short for Local Area Network. This is considered your internal network. These are
the IP settings of the LAN interface for the DI-624. These settings may be referred to as
Private settings. You may change the LAN IP address if needed. The LAN IP address is
private to your internal network and cannot be seen on the Internet.

IP Address-

Subnet Mask-

Local Domain-

The IP address of the LAN interface. The default IP address is:
192.168.0.1

The subnet mask of the LAN interface.
The default subnet mask is 255.255.255.0

This field is optional. Enter in the local domain name.

17



Using the Configuration Menu (continued)

Home > DHCP
- 2 L — &
D-Link AiRlus -
xm&‘ME
High-Speed 2.4GHz Wireless Router
DI-624 | -
' 0T, Advanced  Tools Status Help
The DHE24 can be setup as a DHCP Server to distribute IP addresses to the LAN
it
DHCP Sarver & Enabled © Disabled
e Starting IP Address 192 . 168 .0 [100
Wireless
Ending IP Address 192 168. 0. [193
Lease Time 1 Week
— 2 90

Apply Cancel Help
Host Mame [P Address MAC Address Expired Time

piice unkmewn 1921680101 00-50-BA-7D-ES-E1 Janf03/2003 17.0%:05

A

DHCP stands for Dynamic Host Control Protocol. The DI-624 has a built-in DHCP server.
The DHCP Server will automatically assign an IP address to the computers on the LAN/
private network. Be sure to set your computers to be DHCP clients by setting their TCP/
IP settings to “Obtain an IP Address Automatically.” When you turn your computers on,
they will automatically load the proper TCP/IP settings provided by the DI-624. The
DHCP Server will automatically allocate an unused IP address from the IP address pool
to the requesting computer. You must specify the starting and ending address of the IP
address pool.

DHCP Server- Select Enabled or Disabled. The default setting is Enabled.
Starting

IP Address- The starting IP address for the DHCP server’s IP assignment
Ending

IP Address- The ending IP address for the DHCP server’s IP assignment
Lease Time- The length of time for the IP lease. Enter the Lease time. The

default setting is one hour

18



Using the Configuration Menu (continued)

Advanced > Virtual Server

-
- . — -~
D-Link AirrPlus =
Building Networks for People XTPEMEG
High-Speed 2.4GHz Wireless Router
DI-624 | : .
[ Home WYL IR Tools Status Help
Wirtual Server is used to allow Internet users access to LAN services.
Virtual Server
- € Enabled ' Disabled
Mame | Clear
BIIEE
Protocal Type  |TCP =
Filters Private Port
Public Port
Firewall Schedule © Always
© From time [00 =] : |00 =] |Am =] to |00 =] ; |00 =] |Am =
I day |Bun ¥ to|Sun
DMZ
<@
_— [
Performance .
tual s List Apply Cancel Help
Mame Private IP Protocal Schedule
™ Wirtual Server FTP 0.000 TCP 21721 ahways Bl
[T Virtual Server HTTP 0000 TCP 80/80 ahways Eil
™ WVirtual Server HTTPS 0.00.0 TCP 443/443 ahways Ei
[T Virtual Server DNS 0000 UDP 53/53 always Ei|

The DI-624 can be configured as a virtual server so that remote users accessing Web
or FTP services via the public IP address can be automatically redirected to local
servers in the LAN (Local Area Network).

The DI-624 firewall feature filters out unrecognized packets to protect your LAN
network so all computers networked with the DI-624 are invisible to the outside world.
If you wish, you can make some of the LAN computers accessible from the Internet
by enabling Virtual Server. Depending on the requested service, the DI-624 redirects

the external service request to the appropriate server within the LAN network.

The DI-624 is also capable of port-redirection, meaning incoming traffic to a particular
port may be redirected to a different port on the server computer.

Each virtual service that is created will be listed at the bottom of the screen in the
Virtual Servers List. There are pre-defined virtual services already in the table. You
may use them by enabling them and assigning the server IP to use that particular
virtual service.

19




Using the Configuration Menu (continued)

Advanced > Virtual Server continued

Virtual Server-

Name-

Private IP-

Protocol Type-

Private Port-

Public Port-

Schedule-

Example #1:

Select Enabled or Disabled.
Enter the name referencing the virtual service.

The server computer in the LAN (Local Area Network) that will be
providing the virtual services.

The protocol used for the virtual service.

The port number of the service used by the Private IP computer.

The port number on the WAN (Wide Area Network) side that will
be used to access the virtual service.

The schedule of time when the virtual service will be enabled.
The schedule may be set to Always, which will allow the
particular service to always be enabled. If it is set to Time,
select the time frame for the service to be enabled. If the
system time is outside of the scheduled time, the service will
be disabled.

If you have a Web server that you wanted Internet users to
access at all times, you would need to enable it. Web
(HTTP) serveris on LAN (Local Area Network) computer
192.168.0.25. HTTP uses port 80, TCP.

Name: Web Server

Private IP: 192.168.0.25

Protocol Type: TCP

Private Port: 80

Public Port: 80

Schedule: always

20



Using the Configuration Menu (continued)

Advanced > Virtual Server continued

Virtual Servers List
MNarne Private IP Protocol schedule
B Virtual Server HTTP 192.168.0.25 TCP 804280 always ATl

J' Click on this icon to edit the virtual service

." ll Click on this icon to delete the virtual service

Example #2:

If you have an FTP server that you wanted Internet users to access by WAN port
2100 and only during the weekends, you would need to enable it as such. FTP
server is on LAN computer 192.168.0.30. FTP uses port 21, TCP.

Name: FTP Server
Private IP: 192.168.0.30
Protocol Type: TCP
Private Port: 21

Public Port: 2100

Schedule: From: 01:00AM to 01:00AM, Sat to Sun
All Internet users who want to access this FTP Server
must connect to it from port 2100. This is an example of

port redirection and can be useful in cases where there
are many of the same servers on the LAN network.

21



Using the Configuration Menu (continued)
Advanced > Applications

- < - — -
D-Link AirPlus -
Building Networks for People x7ﬂE'MEG
High-Speed 2.4GHz Wireless Router
DI-624 l - = -
- [ _Home JFYIZUVIEE Tools Status___ Help
S.peciai Ap‘p\icatmn is used to run applications that reguire multiple connections.
e
€ Enabled ¢ Disabled
MName | Clear
Applications Trigger Port I
Trigger Type TCP »
Filters Public Port |
Fublic Type TCP =
Frewall VI +
Special Applications List Apply Cancel Help
BT NAME Trigger Public U
DMz I Battle.net 5112 6112 Ei]
™ Dialpad 7175 51200-51201,51210 (4%
'Perf_ FIcUo 2019 2000-2038,2050-2051,2069,2085,3010-3030 _@Eﬂ
R, ™ MSN Gaming Zone 47624 2300-2400,28200-29000 Bl
™ PC-to-Phone 1205312120,12122,24150-24220 Ei]
™ Quick Time 4 554 6970-6959 il

Some applications require multiple connections, such as Internet gaming, video
conferencing, Internet telephony and others. These applications have difficulties
working through NAT (Network Address Translation). Special Applications makes
some of these applications work with the DI-624. If you need to run applications that
require multiple connections, specify the port normally associated with an application
in the “Trigger Port” field, select the protocol type as TCP or UDP, then enter the
public ports associated with the trigger port to open them for inbound traffic.

The DI-624 provides some predefined applications in the table on the bottom of the
web page. Select the application you want to use and enable it.

Note! Only one PC can use each Special Application tunnel.

Name: This is the name referencing the special application.

Trigger Port: This is the port used to trigger the application. It can be either
a single port or a range of ports.

Trigger Type: This is the protocol used to trigger the special application.

Public Port: This is the port number on the WAN side that will be used to

access the application. You may define a single port or a
range of ports. You can use a comma to add multiple ports or
port ranges.

Public Type: This is the protocol used for the special application.
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Using the Configuration Menu (continued)

Advanced > Filters > IP Filters

D-Link “AirPlus

Building Networks for People anME me
High-Speed 2.4GHz Wireless Router
DI-624
| Home METLTI Took StoiusHelo

Filters are used to allow or deny LAN users from accessing the Internet.

“Virtual Server & P Filters € URL Blocking
© MAC Filters " Domain Blocking

Applications

Use IP Filters to deny LAN IP addresses access to the Internet.

€ Enabled € Disabled Cleat

ifdh ]

P -
Firewall Port I_ | |_
Pratocol TypeITCF' 'l
DMZ Schedule € Ahways
C
e O e [0 [0072] [AWE] 1o [0 =] [o0 =] A ]
Performance day m 4 m
9 90O
Apply Cancel Help
IP Range Protocol Scheduls
E = TCP 20-21 abways [
m TCP 80 abways [

Filters are used to deny or allow LAN (Local Area Network) computers from accessing
the Internet. The DI-624 can be setup to deny internal computers by their IP or MAC
addresses. The DI-624 can also block users from accessing restricted web sites.

IP Filters: Use IP Filters to deny LAN IP addresses from accessing the
Internet. You can deny specific port numbers or all ports for
the specific IP address.

IP: The IP address of the LAN computer that will be denied
access to the Internet.

Port: The single port or port range that will be denied access to the
Internet.

Protocol Type: Select the protocol type.

Schedule: This is the schedule of time when the IP Filter will be enabled.
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Using the Configuration Menu (continued)

Advanced > Filters > URL Blocking

D-Link “AirPlus =

Building Networks for People MﬂEAWE
High-Speed 2.4GHz Wireless Router

" Home IV Tools  Status  Help

DI-624 l

Filters
E—

Filters are used to allow or deny LAN users from accessing the Internet.

VirtuatServer O IP Filters @ URL Blocking
O MAC Filters O Domain Blocking

Applications URL Blocki

ng
Block those URLs which contain keywords listed below.

@ Enabled O Disabled

T
ilaaaa |

" Firewall

i - 2 90O

Apply Cancel Help
Performance

i

URL Blocking is used to deny LAN computers from accessing specific web sites by
the URL. A URL is a specially formatted text string that defines a location on the
Internet. If any part of the URL contains the blocked word, the site will not be
accessible and the web page will not display. To use this feature, enter the text string
to be blocked and click Apply. The text to be blocked will appear in the list. To
delete the text, just highlight it and click Delete.

Filters- Select the filter you wish to use; in this case, URL Blocking
was chosen.

URL Blocking- Select Enabled or Disabled.

Keywords- Block URLs which contain keywords listed below.

Enter the keywords in this space.
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Using the Configuration Menu (continued)
Advanced > Filters > MAC Filters

D Link AirPlus, -
High-Speed 2.4GHz Wireless Router

" Home INCLLTCI Tools  Status  Help

DI-624 l

Filters are used to allow or deny LAM users from accessing the Internet.

Virtual Server O IP Filters O URL Blacking
& MAC Filters ) Domain Elocking

Applications

L

Use MAC address to allow or deny computers access to the network.

Filters O Disabled MAC Filters
@ Only allow computers with MAC address listed below ta access the network
C Only deny computers with MAC address listed below to access the network

Prpy o
' Firewall

Namme [MAC filter 1 |[ Clear |

MAC Address 00 |-[s0 [.[e0 |a1 |[23 |-[eq |
DHCP Client [ v
" Performance a Q o

MAC Filter List Apply Cancel Help
Marme MAC Address

DMZ

-

Use MAC (Media Access Control) Filters to allow or deny LAN (Local Area Network)
computers by their MAC addresses from accessing the Network. You can either manually
add a MAC address or select the MAC address from the list of clients that are currently
connected to the Broadband Router.

Filters- Select the filter you wish to use; in this case, MAC filters was
chosen.

MAC Filters- Choose Disable MAC filters; allow MAC addresses listed be-
low; or deny MAC addresses listed below.

Name- Enter the name here.

MAC Address- Enter the MAC Address.

DHCP Client- Select a DHCP client from the pull-down list; click Clone to
copy that MAC Address.
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Using the Configuration Menu (continued)

Advanced > Filters > Domain Blocking

AirPlus s
EME,

High-Speed 2.4GHz Wireless Router
[ Home ITYLT I Tools Status _ Help

DI-624 l

d
i

Filters are used to allow or deny LAN users from accessing the Internet.

PSRV O IP Filters © URL Blacking
O MAC Filters @ Domain Blocking
Applications [T o R T
O Disabled
Filters @ Allow users ta access all domains except "Blacked Domaing”
) Deny users to access all domains except "Permitted Domains”

Jomains

Firewall ;
|www.d||nk.com|

i
e
T DMZ
T |58

|
| (Beke]

Domain Blocking is used to allow or deny LAN (Local Area Network) computers from
accessing specific domains on the Internet. Domain blocking will deny all requests to a
specific domain such as http and ftp. It can also allow computers to access specific
sites and deny all other sites.

Filters- Select the filter you wish to use; in this case, Domain Blocking
. . was chosen.
Domain Blocking-
Disabled- Select Disabled to disable Domain Blocking.
Allow- Allows users to access all domains except Blocked Domains.
Deny- Denies users access to all domains except
Permitted Domains.
Permitted
Domains- Enter the Permitted Domains in this field.

Blocked Domains- Enter the Blocked Domains in this field.
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Using the Configuration Menu (continued)

Advanced > Firewall

D-Link B7-V/
Building Networks for Peaple A".xE.LL.s’SWEG"

High-Speed 2.4GHz Wireless Router
DI-624 . ,
| ST advonced BT
————

Firewall Rules
Firewall Rules can be used to allow or deny traffic from passing through the D624

YYD € Enabled © Disabled

Name Clear

Applications Action © Allow © Deny
Interface IP Range Start 1P Range End Protocal  Part Range
Source |* jl |
SRS Destination |* dl | |TCP j o

Schedule € Always
© From sime [00 ] - [q0 =] [AM =] 1o [00 ] [00 =] [ =]
day [Sun T|to|Sun >
rewall Rules List Apply Cancel Help
Action  Name Source  Destination Protocol

1]

— -
[# Allow  Allow to Ping WAN port WANT  LAM 192.168.0.1 ICMP & \j
[¥ Deny Default e LAN P
[ Allow  Default LAN® == LU

Firewall Rules is an advanced feature used to deny or allow traffic from passing
through the DI-624. It works in the same way as IP Filters with additional settings.
You can create more detailed access rules for the DI-624. When virtual services are
created and enabled, it will also display in Firewall Rules. Firewall Rules contain all
network firewall rules pertaining to IP (Internet Protocol).

In the Firewall Rules List at the bottom of the screen, the priorities of the rules are
from top (highest priority) to bottom (lowest priority.)

":I?;ebl-624 MAC Address filtering rules have precedence over the Firewall Rules.
Firewall Rules- Enable or disable the Firewall

Name- Enter the name

Action- Allow or Deny

Source- Enter the IP Address range

Destination- Enter the IP Address range; the Protocol;

and the Port Range

Schedule- Select Always or enter the Time Range.
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Using the Configuration Menu (continued)

Advanced > DMZ

D-Link

Buflding Metworks for People

T'Alf'}pﬁ |I.‘IE%’ —_r="

High-Speed 2.4GHz Wireless Router
DI-624 _
l [ Home BB Tools Status Help

DMZ (Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to
the Internet.

Virtual Server
' Enabled & Disahled

IP Address 192 . 168.D.|D

* Applications

Filters o 9 o

Apply Cancel Help

Firewall

Performance

et

If you have a client PC that cannot run Internet applications properly from behind the
DI-624, then you can set the client up for unrestricted Internet access. It allows a
computer to be exposed to the Internet. This feature is useful for gaming purposes.
Enter the IP address of the internal computer that will be the DMZ host. Adding a
client to the DMZ (Demilitarized Zone) may expose your local network to a variety of

security risks, so only use this option as a last resort.

DMZ- Enable or Disable the DMZ. The DMZ (Demilitarized Zone)
allows a single computer to be exposed to the internet. By
default the DMZ is disabled.

IP Address- Enter the IP Address of the computer to be in the DMZ.
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Using the Configuration Menu (continued)

Wireless
Performance-

Displayed in this window are
the Wireless Performance
features for the Access Point Fhpoliclion”
portion of the DI-624.

TX Rates-

Auto is the default selection.
Select from the drop down

menu.

Beacon Interval-

RTS Threshold-

Fragmentation-

DTIM interval-

Preamble Type-

SSID Broadcast-

Advanced > Performance

D-Link “AirPlus

Building Networks for People XﬂEME G""
High-Speed 2.4GHz Wireless Router
DI-624 2
| " Home TR Tool  Stotus Help
These a‘re Ih‘E W\re\ess‘;'ﬂeﬂnrmance features for the AP{Access Paint) Portion
*Virlual Server e |

TX Rate : | Auto ¥ (Mbps)
0 |

Beacon interval : (msec, range:20~1000, default:100)

RTS Threshold : 2348 _|{range: 1~2346, default 2346)
Fragmentation : L2E4E,| (range: 256~2346, default:2345, even number anly)
DTIM interval : |1 | range: 1~255, defautt-1)
Preamble Type : & Short Preamble & Long Preamble
—
Firewall SSID Broadeast : & Enabled O Disabled
802.11g Only Mode : O Enabled @ Disabled
CTSMode: O None © Always @ Auta
Super G Mode : iTSuperG with Dynamic Turbo ~
Disabled
Super G without Turbo
Sup with Dynamic Turbo |
Super G with Static Turbo

—

Filters

By

@ 90

Apply Cancel Help

Beacons are packets sent by an Access Point to synchronize a
wireless network. Specify a value. 100 is the default setting and
is recommended.

This value should remain at its default setting of 2432. If inconsis-
tent data flow is a problem, only a minor modification should be
made.

The fragmentation threshold, which is specified in bytes, deter-
mines whether packets will be fragmented. Packets exceeding
the 2346 byte setting will be fragmented before transmission.
2346 is the default setting.

(Delivery Traffic Indication Message) 3 is the default setting. A
DTIM is a countdown informing clients of the next window for
listening to broadcast and multicast messages.

Select Short or Long Preamble. The Preamble defines the
length of the CRC block (Cyclic Redundancy Check is a com-
mon technique for detecting data transmission errors) for com-
munication between the wireless router and the roaming wire-
less network adapters. Note: High network traffic areas should
use the shorter preamble type.

Choose Enabled to broadcast the SSID across the network.
All devices on a network must share the same SSID (Service
Set Identifier) to establish communication. Choose Disabled
if you do not wish to broadcast the SSID over the network.
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Using the Configuration Menu (continued)

Advanced > Performance (continued)

802.11g only mode- Select this mode to restrict your network to only those devices

CTS Mode-

Super G Mode-

Disabled-

Super G without
Turbo-

Super G with
Dynamic Turbo-

Super G with
Static Turbo-

that employ the 802.11g standard. Enabling this mode will en-
sure that you maintain the highest connectivity rate, unhampered
by any connection to an 802.11b device.

CTS (Clear To Send) is a function used to minimize collisions
among wireless devices on a wireless local area network (LAN).
CTS will make sure the wireless network is clear before a wire-
less client attempts to send wireless data. Enabling CTS will
add overhead and may lower wireless throughput.

None- CTSis typically used in a pure 802.11g environment.
If CTS is set to “None” in a mixed mode environment
populated by 802.11b clients, wireless collisions may
occur frequently.

Always- CTS will always be used to make sure the wireless
LAN is clear before sending data.

Auto- CTS will monitor the wireless network and automati-
cally decide whether to implement CTS based on
the amount of traffic and collisions that occurs on
the wireless network.

Super G is a group of performance enhancement features that
increase end user application throughput in an 802.11g network.
Super G is backwards compatible to standard 802.11g devices.
For top performance, all wirelss devices on the network should
be Super G capable. Select either Disabled, Super G without
Turbo, Super G with Dynamic Turbo, or Super G with Static Turbo.

Standard 802.11g support, no enhanced capabilities.

Capable of Packet Bursting, FastFrames, Compression, and no
Turbo mode.

Capable of Packet Bursting, FastFrames, Compression, and
Dynamic Turbo. This setting is backwards compatible with non-
Turbo (legacy) devices. Dynamic Turbo mode is only enabled
when all nodes on the wireless network are Super G with Dy-
namic Turbo enabled.

Capable of Packet Bursting, FastFrames, Compression, and
Static Turbo. This setting is not backwards compatible with non-
Turbo (legacy) devices. Static turbo mode is always on and is
only enabled when all nodes on the wireless network is Super G
with Static Turbo enabled. 30



Using the Configuration Menu (continued)

Tools> Admin

D:Link A e (T~
High-Speed 2.4GHz Wireless Router

m-ml
U Sictus  Help |

trator Settings

\dminis
Administrators can change their login password

Administrator (The Login Name is "admin”)

New Pagsword [P
Confirm Passward [

User (The Login name is "uset")
—

System Mewr Passward [Fomsess
Confirm Passward [

g

Time

" Firmware

A

[E— € Enabled & Disabled
Misc. IP Address [F

Pnnl@
9 00

Apply Cancel Help

At this page, the DI-624 administrator can change the system password. There are two
accounts that can access the Broadband Router's Web-Management interface. They
are admin and user. Admin has read/write access while user has read-only access. User
can only view the settings but cannot make any changes.

Administrator- admin is the Administrator login name
Password- Enter the password and enter again to confirm
User- user is the User login name

Password- Enter the password and enter again to confirm

Remote Management- Remote management allows the DI-624 to be configured from
the Internet by a web browser. A username and password is still required to access the
Web-Management interface. In general, only a member of your network can browse the
built-in web pages to perform Administrator tasks. This feature enables you to perform
Administrator tasks from the remote (Internet) host.

IP Address- The Internet IP address of the computer that has access to the Broadband
Router. If you input an asterisk (*) into this field, then any computer will be able to access
the Router. Putting an asterisk (*) into this field would present a security risk and is not
recommended.

Port- The port number used to access the Broadband Router.

Example- http://x.x.x.x:8080 where x.x.x.x is the WAN IP address of the Broadband
Router and 8080 is the port used for the Web-Mangement interface.
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Using the Configuration Menu (continued)

Time Zone-

Default
NTP Server-

Set the Time-

Daylight
Saving-

Tools > Time

D-Link =Y
ag LATLIC A!Inrip5 Il.;%' e~

High-Speed 2.4GHz Wireless Router

m-ml
R Sictus  Help |

-

Time
Set the DHE24 system time.
Admin

|¢

Local Time Dec/27/2002 17:31:51

Time Zone [(GMT-08:00) Pacific Time (US & Canada) =l
Default NTP Server li(optlonal)
pathe{ime Vearm Manth m Day Iﬂ

Hourm Minute 'ﬂ Second m

" Firmware " Enabled * Disabled

Daylight Saving - ,__lJan = l__lm B e l__lJa” = |__|E” =

Time

' System

LI

" Misc.

9 0O

Apply Cancel Help

Select the Time Zone from the pull-down menu.

NTP is short for Network Time Protocol. NTP synchronizes com-
puter clock times in a network of computers.
This field is optional.

To manually input the time, enter the values in these fields for
the Year, Month, Day, Hour, Minute, and Second. Click Set Time.

To select Daylight Saving time manually, select enabled or dis-
abled, and enter a start date and an end date for daylight saving
time.
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Using the Configuration Menu (continued)

Tools > System

D-Link

Buflding Networks for People

-AirPlus o
Xrremels
High-Speed 2.4GHz Wireless Router

[_Home _ Advancediiils CWORN Status___Help |

o

System Settings

Save Settings To Local Hard Drive

Save |

Load Settings From Local Hard Drive

| Browse |
Load |

e = 3k
* irmware

Restare To Factory Default Settings

Restora |

Help

The current system settings can be saved as a file onto the local hard drive. The saved
file or any other saved setting file can be loaded back on the Broadband Router. To reload
a system settings file, click on Browse to browse the local hard drive and locate the
system file to be used. You may also reset the Broadband Router back to factory set-
tings by clicking on Restore.

Save Settings to
Local Hard Drive- Click Save to save the current settings to the local Hard Drive

Load Settings from
Local Hard Drive- Click Browse to find the settings, then click Load

Restore to Factory

Default Settings- Click Restore to restore the factory default settings
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Using the Configuration Menu (continued)

Tools > Firmware

D-Link A
Building Networks for People Al"%‘lﬂ‘.lﬁ%ys héoad

High-Speed 2.4GHz Wireless Router

[__Home _ AdvancedfillE PPN Sigtus__ Help

-l

Firmware Upgrade

There may be new firmware for your D624 to improve functionality and performance.
Click here to check for an upgrade on our support site.

To upgrade the firmware, locate the upgrade file on the local hard drive with the Browse
button. Once you have found the file to be used, click the Apply button below to start the
firmware upgrade.

' Admin

D624 |
@

il
——

Current Firmware Version: 1.00
Firmware Date: Tue, 24 Dec 2002

Browse |
Firmware o 33 o

Apply Cancel Help

You can upgrade the firmware of the Router here. Make sure the firmware you want to
use is on the local hard drive of the computer. Click on Browse to browse the local hard
drive and locate the firmware to be used for the update. Please check the D-Link support
site for firmware updates at http://support.dlink.com. You can download firmware up-
grades to your hard drive from the D-Link support site.

Firmware Upgrade-Click on the link in this screen to find out if there is an updated
firmware; if so, download the new firmware to your hard drive.

Browse- After you have downloaded the new firmware, click Browse in

this window to locate the firmware update on your hard drive.
Click Apply to complete the firmware upgrade.
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Using the Configuration Menu (continued)

Ping Test-

Restart
Device-

Block
WAN
Ping-

UPNP-

Gaming
Mode-

Dynamic
DNS-

VPN
Pass
Through-

Tools > Misc

The Ping Test is used to
send Ping packets to test if
a computer is on the = wma

AinPlus =
Morenmels
High-Speed 2.4GHz Wireless Router

Internet. Enter the IP Ad- % m - mﬂ
dress that you wish to Ping, e T )m
and click Ping.
Click Reboot to restart the -—
DI-624. —

[

If you choose to block WAN
Ping, the WAN IP Address
of the DI-624 will not respond
to pings. Blocking the Ping
may provide some extra se-
curity from hackers.

Discard Ping from
WAN side-

Click Enabled to block the
WAN ping.

To use the Universal Plug and Play feature click on Enabled. UPNP
provides compatibility with networking equipment, software and periph-
erals of the over 400 vendors that cooperate in the Plug and Play forum.

Gaming mode allows a form of pass-through for certain Internet Games.
If you are using Xbox, Playstation2 or a PC, make sure you are using
the latest firmware and Gaming Mode is enabled. To utilize Gaming
Mode, click Enabled. If you are not using a Gaming application, it is
recommended that you Disable Gaming Mode.

Dynamic Domain Name System is a method of keeping a domain name
linked to a changing IP Address. This is a useful feature since many
computers do not use a static IP address.

The DI-624 supports VPN (Virtual Private Network) pass-through
for both PPTP (Point-to-Point Tunneling Protocol) and IPSec
(IP Security). Once VPN pass-through is enabled, there is no
need to open up virtual services. Multiple VPN connections can
be made through the DI-624. This is useful when you have many
VPN clients on the LAN network.

PPTP- select Enabled or Disabled

|IPSec- select Enabled or Disabled 35



Using the Configuration Menu (continued)

Status > Device Info

EME,
High-Speed 2.4GHz Wireless Router

DI-624
I Home  Advanced  Tools Status I!E_

. .Firmware Version: 1.00 , Tue, 24 Dec 2002

AirPlus -
P

Device Info Ean
MAC Address 00-03-2F-FF-FI-85

IP Address 192.168.0.1
Subnet Mask 255.255 255.0
DHCP Server Enabled
Stats
VAN

T Gl MAC Addi (00-03-2F-FF-FO-86
Wireless e

] g

Connection DHCP Client Connected  BHCP Release DHCP Renew

IP Address 10.80.1.94
Subnet Mask 255.0.0.0
Default Gateway 10.10.10.100
DNS 10.10.10.41 10.10.10.45 192152811

Wireless 802.11g
MAC Address 00-50-83-06-00-32

SSID GiGi

This page displays the current information for the DI-624. It will display the LAN, WAN
and MAC address information.

If your WAN connection is set up for a Dynamic IP address then a Release button and
a Renew button will be displayed. Use Release to disconnect from your ISP and use
Renew to connect to your ISP.

If your WAN connection is set up for PPPoE, a Connect button and a Disconnect button
will be displayed. Use Disconnect to drop the PPPoE connection and use Connect to
establish the PPPoE connection.

This window will show the DI-624’s working status:

WAN

LAN

Wireless

IP Address: WAN/Public IP Address

Subnet Mask: WAN/Public Subnet Mask

Gateway: WAN/Public Gateway IP Address
Domain Name Server: WAN/Public DNS IP Address
WAN Status: WAN Connection Status

IP Address: LAN/Private IP Address of the DI-624
Subnet Mask: LAN/Private Subnet Mask of the DI-624

MAC Address: Displays the MAC address

SSID: Displays the current SSID

Channel: Displays the current channel

WEP: indicates whether WEP is enabled or disabled
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Using the Configuration Menu (continued)

Status > Log

D-Link

Buflding Networks for People

DI-624 l

: Device Info

PE——
" Wireless

=
Log

High-Speed 2.4GHz Wireless Router
Home Advanced | Tools Status m

View Log
Wiew Log displays the activities occurring on the DIE24. Click on Log Settings for advance
features.

First Page Last Page Hreyions | Nexll Clearl Log Settings | Help

page 1 of 1

Time Message Source Destination Mate
Dec/27/2002 17.09:11  DHCP Eequest success 10.80.1.%4
Decf27/2002 17.09:11  DHCP Eequest 10.80.1.94

Dec/27/2002 17.09:11 DHCP Discover
Dec/27/2002 17.09.07  System started
Decf27i2002 17:09:07  DHCP Discower

The Broadband Router keeps a running log of events and activities occurring on the
Router. If the device is rebooted, the logs are automatically cleared. You may save the log
files under Log Settings.

View Log-

First Page - The first page of the log

Last Page - The last page of the log

Previous - Moves back one log page

Next - Moves forward one log page

Clear - Clears the logs completely

Log Settings - Brings up the page to configure the log
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Using the Configuration Menu (continued)

Status > Log > Log Settings

D-Link “AirPlus 2

Buflding Networks for People XnWE
High-Speed 2.4GHz Wireless Router

DI-624 :
| Home  Advanced  Tools Status I!E_

" = Loy settings
Logs can be saved by sending it to an admin email address.
—
Device Info
SMTP Setvet / 1P Address |

Email Address | Send Mail Mo

Log Type ¥ System Activity

Log
 E————— [T Debug Inforrmation
* Stats .
¥ Attacks

" Dropped Packets

—_—
" Wireless

¥ Matice

2 90

Apply Cancel Help

Not only does the Broadband Router display the logs of activities and events, it can be
setup to send these logs to another location.

SMTP Server/
IP Address - The address of the SMTP server that will be used to send the

logs.

Email Address -  The email address to which the logs will be sent.
Click on Send Mail Now to send the email.
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Using the Configuration Menu (continued)
Status > Stats

D-Link

Buflding Networks for People

:34”-,!:'5 Il.é% —_r="

High-Speed 2.4GHz Wireless Router
| Heip
Traffic Statistics display Receive and Transmit packets passing through the DIFE24.

Refresh | Reset |

DI-624 |
Advanced

Home

“ — Traffic Statistics

Tools Status

Device Info

o

Help
f Log Receive Transmit
VAN 3964 Packets 277 Packets
LAN 1317 Packets 2321 Packets

WIRELESS 11g 553 Packets 0 Packets

Stats

_—

The screen above displays theTraffic Statistics. Here you can view the amount of pack-
ets that pass through the DI-624 on both the WAN and the LAN ports. The traffic counter
will reset if the device is rebooted.

Status > Wireless

Ar:Plus L
IENE
High-Speed 2.4GHz Wireless Router

DI-624 -
l Home % Advanctdll Toot “Helo |
e ‘Connected Wireless Client List - il
e o

The Wireless Client table below displays Wireless clients Connected to the AP
fro—————
" Device Info Help

(Access Point).
!
Log

* Stats

Wireless

Status

Connected Time MAC Address Mode

The wireless client table displays a list of current connected wireless clients. This
table also displays the connection time and MAC address of the connected wireless
client.

Click on Help at any time, for more information.
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Networking Basics

Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using
Microsoft Windows XP.

Note: Please refer to websites such as http.//www.homenethelp.com
and http://www.microsoft.com/windows2000 for information about networking

computers using Windows 2000, ME or 98.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Metwork Setup Wizard

Welcome to the Network Setup
% Wizard

Thiz wizard will help you set up this computer (o un on your
network. With a network, pou can:

Share an Internet connection

Set up Internet Connection Firewall
Share files and folders

Share a printer

LI R

To continue, click Mest.

[ Cancel

When this screen appears, Click Next.
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Networking Basics

Please follow all the instructions in this window:

Network Setup Wizand

Before you continue.__

Before you continue, review the thecklist for creating a netwark.

Then, complete the following steps:

+ Inztall the network cards, modems, and cables.

+ Tun on all computers, printerz, and external modems.
+ Connect ta the Intermet.

“When pou click Mest, the wizard will search for a shared Intermet connection on your network.

Click Next.

In the following window, select the best description of your computer. If your computer
connects to the internet through a gateway/router, select the second option as shown.

Network Setup Wizard
Select a connection method. %

Select the statement that best describes this computer:

() Thiz computer connects directly to the Intemnet. The other computers on my network connect
to the Internet through this computer,

Wiew an example.

@

is computer connects to the [ntemet through another computer on my network. or through
.

() Other

Learn miore about hame or small affice netwark confiqurations.

r—

< Back l Mewt > ' Cancel

Click Next.
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Networking Basics

Enter a Computer description and a Computer name (optional.)

Network Setup Wizard
Give this computer a description and name.

[Qomputer deszcriphion: Mary's Computer

—

Examples: Family Room Computer or Monica's Computer

[ Computer narme: Office ]
Evamples. FAMILT of MONICE

The current computer name iz Office

Learn mare about computer names and descriptions.

< Back l Mext = ' Cancel

Click Next.

Enter a Workgroup name. All computers on your network should have the same
Workgroup name.

Metwork Setup Wizand

MName your network.

Mame your netwark, by specifving a workgraup hame belaw. All computers on pour netwark,
should hawve the same work group name.

“Workgroup name: Accounting

Examples HOME or OFFICE

< Back Mext » Cancel

Click Next.
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Please wait while the Network Setup Wizard applies the changes.

Network Setup Wizard

Ready to apply network sethings. .

The wizard will apply the following settings. This pracess may take a few minutes to complate
and cannot be interupted.

Settings:
Metwork settings: A
Computer description: Mary's Computer
Computer name: Office
‘wiorkgroup name: Accounting
The Shared Documents folder and any printers connected to this computer have been
shared.
v

To apply these settings, click Mest.

’ < Back ﬂ Mest » i[ Cancel
\

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer.
This may take a few minutes.

Hetwork Setup Wizard

Pleaze wait._.

Pleaze wait while the wizard configures thiz computer for home or small office networking, T his
process may take a few minutes.
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In the window below, select the option that fits your needs. In this example, Create a
Network Setup Disk has been selected. You will run this disk on each of the

computers on your network. Click Next.

Network Setup Wizard

You're almost done...

® - You need to run the Metwork Setup wizard once on each of the computers an your
J\:) network. To run the wizard on computers that are not running *Windows P, you can use
the Windows *P CD or a Metwork Setup Digk.

“w'hat do you want to da?

() Use the Netwark Setup Disk | alieady have
() Use my Windaws XF CD

(2 Just finish the wizard; | don't need ta run the wizard on other computers

e

Insert a disk into the Floppy Disk Drive, in this case drive A.

Network Setup Wizand

Inzernt the dizk you want to use.

Inzert a disk the inta the follawing disk drive, and then click Mest.
3% Floppy [&:)

If you watt to format the disk, click Format Disk.

Click Next.
44



Networking Basics

X]

Copying...

=~ LV

Please wait while the wizard copies files, ..

[ ) Zancel |

Please read the information under Here’s how in the screen below. After you complete
the Network Setup Wizard you will use the Network Setup Disk to run the Network

Setup Wizard once on each of the computers on your network. To continue click Next.

Metwork Setup Wizand

To run the wizard with the Network Setup Disk_.. %

® . Complete the wizard and restart this computer. Then, uze the Metwork Setup Disk to run
\4) the Metwaork Setup Wizard ance on each of the other camputers an paur netwark.

Here's how:
1. Inzert the Metwork Setup Dizk into the nest computer you want to nebwark,

2. Open My Computer and then open the Metwork Setup Digk.
3 Double-chick "netzetup "

45



Networking Basics

Please read the information on this screen, then click Finish to complete the
Network Setup Wizard.

Hetwork Setup Wizand

Completing the Network Setup
Wizard

You have successfully set up this computer for home or zmall
office networking.

For help with home or zmall office nebworking, zee the
fallowing topics in Help and Support Canter:

+ Uszing the Shared Documents folder
+ Sharing filez and folders

To zee other computars an your nebwaork, click Start, and then
click My Metwark Places.

To cloze thiz wizard, click Finizh.

< Back Finish |

The new settings will take effect when you restart the computer. Click Yes to restart
the computer.

System Settings Change |g|

P You must reskark your computer before the new settings will take effect.,
-

o

Do wou want ko restark your computer now?

I oves | [ Mo

You have completed configuring this computer. Next, you will need to run the Network
Setup Disk on all the other computers on your network. After running the Network

Setup Disk on all your computers, your new wireless network will be ready to use.
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Naming your Computer

To name your computer, please follow these directions:In Windows XP:

B Click Start (in the lower left corner of the screen)

B Right-click on My Computer

B Select Properties and click

., Internet
g Internet Explorer
w5 E-mail

A Outlook Express

(X _Crmand Prompk

v 3N Explorer

c.‘) windows Media Player
@ Windows Movie Maker
@ Tour \Windows XP
?

Files and Settings Transfer
“Wizard

_-_] My Documents
=1
43 My Recent Documents »

_f} My Pictures
]

-~} My Music
l My Computer
Open

‘J My Network  Explare
| Search...
G’ Control Pane]  Manage
Map Metwork Drive. ..

e Connect Ta
=1

:é Printers and F

Disconnect Metwark Drive, ..

Show on Desktop
Rename

B Select the Computer
Name Tab in the System
Properties window.

B You may enter a
Computer Description if
you wish; this field is
optional.

m Torename the computer
and join a domain, Click
Change.

System Properties

Remote
Advanced

tic Updates

System Rest
| Computer Hame ||

General | Hardware

el

>

Computer description:

Windows uzes the following information to identify your computer
ot the netwark,

For example; "Fitchen Computer or "Mary's
Carnputer'.
Full computer name:  Office

Wwhark group: Accounting

To uzge the Metwork, Identification Wizard to join &
domain and create a local user account, click Metwork,

Torename this computer or join a domain, click Change.
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Naming your Computer

B In this window, enter the Computer Name Changes

Computer name.
Yaou can change the name and the membership of thiz
computer. Changes may affect access to network resources.

B Select Workgroup and enter
the name of the Workgroup.

Computer name:
Office
B All computers on your network _
Full computer name:
must have the same Office
Workgroup name.

More. ..

B Click OK. tember of.
() Domair

(=) whorkgroup:
Accounting

ox ) oo ]

Checking the IP Address in Windows XP

The wireless adapter-equipped computers in your network must be in the same IP Ad-
dress range (see Getting Started in this manual for a definition of IP Address Range.) To
check on the IP Address of the adapter, please do the following:

B Right-click on the Disable
Connection icon

in the task bar. Repair

Wiew Awailable Wireless Metworks

Open MNetwork Connections
B Click on Status.
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Checking the IP Address in Windows XP

Wireless Network Connection 7 Status |E||z|

General |i Support .

This window will appear.

Internet Pratocal [TCPAAF)

| Click the
Support tab Address Type: Agzzigned by DHCP
| 1P addess 1921680114 |
Subret Mazk: 255.255.255.0
Default Gateway: 132168.0.1

[ | Click Close

Close

Assigning a Static IP Address in Windows XP/2000

Note: Residential Gateways/Broadband Routers will automatically assign IP Addresses
to the computers on the network, using DHCP (Dynamic Host Configuration Protocol)
technology. If you are using a DHCP-capable Gateway/Router you will not need to assign
Static IP Addresses.

If you are not using a DHCP capable Gateway/Router, or you need to assign a Static IP
Address, please follow these instructions:

] |_E.-— Contral Panel
-_.@ Taur windows ¥P
{;é Printers and Faxes
}g Painit

y | Files and Settings Transfer

. . Wizard
n Double-click on ,-) Search

Control Panel
All Programs D ERU”"'

ﬁ| Lag off |6| Turn OFF Camputer

u Go to Start

g) Help and Suppart
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Assigning a Static IP Address in Windows XP/2000

B Control Panel

File Edit View Favarites Tools Help
% —
d Back (<>} ﬁ /'_) Search [Ff Faolders v
Address [} Control Panel
= 7%, Accessibility Options
u’ Control Panel L dd Herdware
. D bl I k ;Q;Add ar Remove Programs
ouble-click on [} Switch ko Cakegory Yisw A Administrative Tools
Network —# Date and Time
Connections See Alsa
ﬂ eSS 7 Game Controllers
@) Help and Support Plnkernet Options
Phone and Modem Options
Sy Power Options
aPrinters and Faxes
e Regional and Language Options
= Scanners and Cameras
‘) 5cheduled Tasks
) Sounds and Audio Devices
[r—
‘g Start,
" Network Connections
File Edt View Favorites Tools  Advanced  Help
Qo - O - [F| O search [ Fokders
& Hetwork Connections
A Mame
Network Tasks § LAN or High-Speed Internet
[ Create anew
connection Disable
. . % Setupah il Stat
B Right-click on Local Area e puotus
H @ Dissble this network _—
Connections s Brdge Connectins
S - [
8, Repair this cornection Croate it
B[} Rename this connection Delete
& view status of this Rename

connection
Change settings of this
connection

B Double-clickon
Pro perties Other Places

@ Control Panel b
\_} My Netwark Places

(L) My Documents

i My Computer

Details
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Assigning a Static IP Address
in Windows XP/2000

B Click on Internet Protocol
(TCPIIP)

B Click Properties

® Input your IP address and
subnet mask. (The IP
Addresses on your network
must be within the same
range. For example, if one
computer has an IP Address
of 192.168.0.2, the other
computers should have IP
Addresses that are
sequential, like 192.168.0.3
and 192.168.0.4. The subnet
mask must be the same for
all the computers on the
network.)

B Input your DNS server
addresses. (Note: If you
are entering a DNS
server, you must enter the
IP Address of the Default
Gateway.)

The DNS server information will be supplied

by your ISP (Internet Service Provider.)

B Click OK

-L Local Area Connection 7 Properties

EE3

General | Advanced

Connect using:

E  D-Link DWL-AE50

This connection uzes the following items:

Igl, Clignt for Microzoft Metworks

S File and Printer Sharing for Microzoft Networks
B 05 Packet Scheduler
Intemet Pratocal [TCP/P) I

[ escription

Tranzmizzion Contral Protocaol/|ntermet Protocol. The default
wide area network, protocol that provides communication
aciogs diverse inkerconnected networks.

[ Show icon in notifization area when connected

Ok ] [ Cancel

Internet Protocol (TCP/IP) Properties @E|

General

You can get IP settings assigned automatically if your network, supports
this capability. Otherwize, you need to ask your netwark. administrator for
the appropriate [P settings.

(C) Obtain an IF address automatically

‘@ Uze the fallowing IP address: '
1P address: 192 .168. 0 . 2
Subnet mazk: 28928602856 0

Default gateway:

(@ Usg the following DNS server addresses.)

Preferred DMS server

Alernate DMS server

Ce )
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Assigning a Static IP Address with Macintosh OSX

1) =
) -F X NN
B Go to the Apple Menu and se- m m e me s e
lect System Preferences S P i
N R
| i ey
Click on Network o @ Q i
‘88 Netwark [=]
B Select Built-in Ethernetinthe '« = & @ o
Show pull-down menu _
Location:  Automatic ?‘
Show: | Bulh-in Ethernet i
m SelectManually inthe Con- - G
figure pull-down menu T i
Using BootP

e Servers iOpdomal
1P Address
(Provided by DHCP Server)
Subnet Mask: 255.255.255.0
Router: 192.188.0.1 Search Domains Dpeionall
DHCP Client 1D
(Dpcionaly

Lnample: agale.com. earthlinknet
Ethernet Address.

(@) Click the lock to prevent further changes.

‘88 Nerwark =

« HA@ 3@

Show All  Duplays Sound Network Startup Disk

Location:  Automatic -=-1

B Inputthe Static IP Address, UL —

the Subnet Mask and the o L o
Router IP Address in the ap- Costguon: [Ty G

propriate fields ) Pemnfmetomone

1P Address. 16216802

Subnet Mask:  255.255.255.0
. Search Domains iDpeional)

Eouter

Lxample: agple.com. sarthlinknet
Ethernet Address. D0.09.93.75.de-5a

B Click Apply Now

(&) Click the lock to prevent further changes. (" Apply Now
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Selecting a Dynamic IP Address with Macintosh OSX

B  Go to the Apple Menu and select

System Preferences

B Click on Network

Show pull-down menu

B Select Using DHCP in the
Configure pull-down menu

B Click Apply Now

B ThelP Address, Subnet
mask, and the Router’s IP
Address will appear in a few
seconds

Select Built-in Ethernet in the

e =
w & D ]
Persanl
- = B @ & @
[ I i
Harduars
e = @ % 4
[ . T =]
Irhereet & etz
s@ar
—— R
Stem
9 & & @ 4
c DeniTes  Mhwe  Geeh  NewmOik U
®0 Nework =
« @A O
Show AN Dwplays Scund Network  S1ariup Duk
Location: | Automatic 5
Shew:  Bulh-in Ethernat -ﬂ
——- = e —y
—— Manually s
+ Using DHCP
S CooT
1P Address
(Provided by DHCP Server)
Submet Mask. 255.255.255.0
Router 19216801 SEAER DO ifts —— opRcnih
DHCP Client 1D
iOptienal
Fram e eom, rarthliok net
Ethernet Addrec ezian o =
@ Click the lock to prevent fusther changes. Apply Now
[-):] Netwark (=]

“« = A4 3

Show Al Dhiplays Sound Network Startup Disk

Location: | Autamatic )
Shaw: | Built-in Ethernet 3]
feene | preok | AppleTalk | Proxies
Configure: | Using DHCP i)

Domain Name Servers iOgtianali
P Address: 192.168.0.160
{Pravadied by DHCF Serven)
Subnet Mask 255 255.255.0

Router: 192,168.0.1 Search Damaing (Dptianal)

DHCP Client 1D
IDprianal)

Example; agole.com, earthlinknet

Ethernet Address: 00.06.98: 79 de 52

(&) Chck the lnck to prevent further changes  Apply Now




Networking Basics
Checking the Wireless Connection by Pinging in Windows XP and

2000

m GotoStart>Run > BEE
type cmd. Awindow et e P o B
Similar to thls one [F:\Documents and Settings\lab4>ping 192.168.8.58

ll T Pinging 192.168.0.50 with 32 hytes of data:
Wi appear' ype Rewly fron 192.168.0.50: hyt

A cply £rom :
ping Fonly Fron 175.165.0.58:

XXX XXX XXX.XXX, T
where xxx is the IP SIS RE LN HRAE R
Address of the IP:\Documents and Settings\lah4>_
Wireless Router or
Access Point. A
good wireless
connection will show
four replies from the
Wireless Router or
Acess Point, as
shown.

Checking the Wireless Connection by Pinging in Windows Me
and 98

B Goto Start> Run
> type command.
A window similar to
this will appear.
Type ping
XXX XXX XXX. XXX
where xxx is the IP  EEeST=
Address of the S
Wireless Router or
Access Point. A
good wireless
connection will
show four replies
from the wireless
router or access
point, as shown.
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Troubleshooting

This Chapter provides solutions to problems that can occur during the installation and
operation of the DI-624 Wireless Broadband Router. We cover various aspects of the
network setup, including the network adapters. Please read the following if you are having
problems.

Note: Itis recommended that you use an Ethernet connection to
configure the DI-624 Wireless Broadband Router.

1.The computer used to configure the DI-624 cannot access the
Configuration menu.

B Check that the Ethernet LED on the DI-624 is ON. If the LED is not
ON, check that the cable for the Ethernet connection is securely
inserted.

B Check that the Ethernet Adapter is working properly. Please see
item 3 (Check that the drivers for the network adapters are
installed properly) in this Troubleshooting section to check that

the drivers are loaded properly.

B Check that the IP Address is in the same range and subnet as the
DI-624. Please see Checking the IP Address in Windows XP in
the Networking Basics section of this manual.

Note: The IP Address of the DI-624 is 192.168.0.1. All the computers on the
network must have a unique IP Address in the same range, e.g., 192.168.0.x.
Any computers that have identical IP Addresses will not be visible on the
network. They must all have the same subnet mask, e.g., 255.255.255.0

B Do aPing test to make sure that the DI-624 is responding. Go to
Start>Run>Type Command>Type ping 192.168.0.1. Asuccessful
ping will show four replies.

[~ cwoomsspmiendon  GIR
Note: If you have
changed the default IP
Address, make sure to
2, @ Tosed, ping the correct IP
o Address assigned to the
DI-624.
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Troubleshooting

2. The wireless client cannot access the Internet in the
Infrastructure mode.

Make sure the wireless client is associated and joined with the correct Access
Point. To check this connection: Right-click on the Local Area Connection icon
in the taskbar> select View Available Wireless Networks. The Connect to
Wireless Network screen will appear. Please make sure you have selected the

correct available network, as shown in the illustrations below.

Disable The followaing network[z) are available. To access a network, select
it from the list. and then click Connect.
Status

Repair Available nebworks:

i alan ~

Wigw Available Wirelass Networks dan
Open Network Connections _ =z
T
a

If you are having difficulty connecting ta a netwark, click Advanced.

[ Connect l[ Cancel ]

B Check that the IP Address assigned to the wireless adapter is within the
same IP Address range as the access point and gateway. (Since the
DI-624 has an IP Address of 192.168.0.1, wireless adapters must have
an IP Address in the same range, e.g., 192.168.0.x. Each device must
have a unique IP Address; no two devices may have the same IP
Address. The subnet mask must be the same for all the computers on
the network.) To check the IP Address assigned to the wireless adapter,
double-click on the Local Area Connection icon in the taskbar >
select the Support tab and the IP Address will be displayed. (Please
refer to Checking the IP Address in the Networking Basics section of
this manual.)

B Ifitis necessary to assign a Static IP Address to the wireless adapter,
please refer to the appropriate section in Networking Basics. If you are
entering a DNS Server address you must also enter the Default
Gateway Address. (Remember that if you have a DHCP-capable router,
you will not need to assign a Static IP Address. See Networking

Basics: Assigning a Static IP Address.)
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Troubleshooting

3. Check that the drivers for the network adapters are

installed properly.
You may be using different network adapters than those illustrated here, but this
procedure will remain the same, regardless of the type of network adapters you are
us’”g- T’) Windows Media Player I

Open
Explore

B’ Control P Search...

Manage
e Conneck
5]

|:é Printers 2

Map Metwork Drive, .,
Disconnect Metwork Drive. .

v Show on Desktop

9) Help and|  Rename

m Goto Start> My 2 search
Computer >
Properties O Run...

All Programs D

Turn COff Computer

' start

System Properties

m Select the

Hardware | System Festors || Automatic |Jpdate
Tab | General || Computer Mame ¢ H

Remate
Advanced

Add Hardware Wizard
§ The Add Hardware “Wizard helps you install hardware,

Add Hardware Wizard

Device M anager

B Click Device
Manager

The Device Manager lists all the hardware devices installed
on pour computer, Use the Device Manager to change the
properties of any device.

’ Diriver Signing ] i Device Manager ;

N et

Hardware profiles provide a way for you to set up and store
different hardware configurations.

Hardware Profiles

[ Hardware Profiles ]

ak l[ Cancel ] Apply




Troubleshooting

Double-click
on Network
Adapters

Right-click on D-Link
AirPlus DWL-G650
Wireless Cardbus
Adapter (In this example
we use the DWL-G650;
you may be using other
network adapters, but the
procedure will remain the
same.)

Select Properties
to check that the
drivers are in-
stalled properly

Look under Device
Status to check that the
device is working

properly

Click OK

Z¢ Device Manager

File  Action Wew Help
& 2

= &, prTEST
+ ﬁ Eatteries
+- ¢ Computer
+- g Disk drives
+ j Display adapters
+-i=) Flappy disk contrallers
+ ﬂ, Floppy disk drives
(=) 1DE ATASATAPT controllers
‘2z Keyboards
) WMice and other pointing devices
L Modems
7 Monitars
=25 Mebwork adapters
EEF D-Link AirPlus DWL-G650
§ PCMCIA adapters
5 Parts (COM & LPT)
% Processors
@, sound, video and game controllers

System devices
Universal Serial Bus controllers

&[] [ [

+
S
+
S
+
e

D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

General | Advanced | Settings | Driver | Resources

D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

Device bype: Metwork adapters
Marufacturer: D-Link
Location: PCl busz 5, device 0, function 0

Device statuz

This device is working properly.

If you are having problems with thiz device, click Troubleshoot to
shart the troubleshooter.

Troubleshoot. ..

Device uzage:

Use thiz device [enable] v

l oK. ' Cancel
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Troubleshooting

4. What variables may cause my wireless products
to lose reception?

D-Link products let you access your network from virtually anywhere you want. However,
the positioning of the products within your environment will affect the wireless range.
Please refer to Installation Considerations in the Wireless Basics section of this manual
for further information about the most advantageous placement of your D-Link wireless
products.

5. Why does my wireless connection keep dropping?

m Antenna Orientation- Try different antenna orientations for the DI-624. Try to
keep the antenna at least 6 inches away from the wall or other objects.

W If you are using 2.4GHz cordless phones, X-10 equipment or other home secu-
rity systems, ceiling fans, and lights, your wireless connection will degrade dra-
matically or drop altogether. Try changing the Channel on your Router, Access
Point and Wireless adapter to a different Channel to avoid interference.

B Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, monitors, electric motors, etc.

6. Why can’t | get a wireless connection?

If you have enabled Encryption on the DI-624, you must also enable encryption on all
wireless clients in order to establish a wireless connection.

B For 802.11g, the Encryption settings are: 64 or 128 bit. Make sure that the
encryption bit level is the same on the Router and the Wireless Client.

B Make sure that the SSID on the Router and the Wireless Client are exactly the
same. If they are not, wireless connection will not be established.

B Move the DI-624 and the wireless client into the same room and then test the
wireless connection.

B Disable all security settings. (WEP, MAC Address Control)
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Troubleshooting

6. Why can’t | get a wireless connection? (continued)

Turn off your DI-624 and the client. Turn the DI-624 back on again, and then turn
on the client.

Make sure that all devices are set to Infrastructure mode.

Check that the LED indicators are indicating normal activity. If not, check that the
AC power and Ethernet cables are firmly connected.

Check that the IP Address, subnet mask, gateway and DNS settings are cor-
rectly entered for the network.

If you are using 2.4GHz cordless phones, X-10 equipment or other home security
systems, ceiling fans, and lights, your wireless connection will degrade dramati-
cally or drop altogether. Try changing the Channel on your DI-624, and on all the
devices in your network to avoid interference.

Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, monitors, electric motors, etc.

7. | forgot my encryption key.

Reset the DI-624 to its factory default settings and restore the other devices on
your network to their default settings. You may do this by pressing the Reset
button on the back of the unit. You will lose the current configuration settings.
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Troubleshooting

8. Resetting the DI-624 to Factory Default Settings

After you have tried other methods for troubleshooting your network, you may
choose to Reset the DI-624 to the factory default settings. Remember that D-
Link AirPro products network together, out of the box, at the factory default
settings.

Reset

To hard-reset the DI-624 to Factory Default Settings, please do the following:

B | ocate the Reset button on the back of the DI-624
B Use a paper clip to press the Reset button

B Hold for about 10 seconds and then release

m After the DI-624 reboots (this may take a few minutes) it
will be reset to the factory Default settings
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Technical Specifications

Standards
m |EEE 802.119g
B I|IEEE802.11b

m |EEE 802.3
m |EEE 802.3u
VPN Pass Through/ Multi-Sessions
m PPTP
B L2TP
m |PSec

Device Management

B Web-Based- Internet Explorer v6 or later; Netscape Navigator v6
or later; or other Java-enabled browsers

B DHCP Server and Client

Advanced Firewall Features

B NAT with VPN Passthrough (Network Address Translation)
MAC Filtering
IP Filtering
URL Filtering
Domain Blocking
B Scheduling
Wireless Operating Range
B Indoors — up to 328 feet (100 meters)
B Outdoors — up to 1312 feet (400 meters)
Operating Temperature
B 32°F to 131°F (0°C to 55°C)

Humidity:
B  95% maximum (non-condensing)

Safety and Emissions:
B FCC

Wireless Frequency Range:
B 24GHzto 2.462GHz

62



Technical Specifications

LEDs:

Power

WAN

LAN (10/100)

WLAN (Wireless Connection)

Physical Dimensions:

B L =7.56inches (192mm)
B W =4.65 inches (118mm)
m H=1.22inches (31mm)

Wireless Transmit Power:
B 15dBm *2dB

Security:

B 802.1x

B  WPA- WiFi Protected Access
(64-,128-WEP with TKIP, MIC, IV Expansion, Shared Key
Authentication)

External Antenna Type:
B Single detachable reverse SMA

Modulation Technology:
B Orthogonal Frequency Division Multiplexing (OFDM)

Power Input:
B Ext. Power Supply DC 5V, 3.0A

Weight:

m 10.8 oz. (0.3kg)
Warranty:

B 3year
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Technical Specifications

Wireless Data Rates with Automatic Fallback:

108 Mbps
54 Mbps
48 Mbps
36 Mbps
24 Mbps
18 Mbps
12 Mbps
11 Mbps
9 Mbps
6 Mbps
5.5 Mbps
2 Mbps

1 Mbps

Receiver Sensitivity:

m 108Mbps

B 54Mbps OFDM, 10% PER, -68dBm
B 48Mbps OFDM, 10% PER, -68dBm
36Mbps OFDM, 10% PER, -75dBm
24Mbps OFDM, 10% PER, -79dBm
18Mbps OFDM, 10% PER, -82dBm
12Mbps OFDM, 10% PER, -84dBm
11Mbps CCK, 8% PER, -82dBm
9Mbps OFDM, 10% PER, -87dBm
6Mbps OFDM, 10% PER, -88dBm
5.5Mbps CCK, 8% PER, -85dBm
2Mbps QPSK, 8% PER, -86dBm
1Mbps BPSK, 8% PER, -89dBm
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Frequently Asked Questions

Why can’t | access the web based configuration?

When entering the IP Address of the DI-624 (192.168.0.1), you are not connecting to
the Internet or have to be connected to the Internet. The device has the utility built-in

to a ROM chip in the device itself. Your computer must be on the same IP subnet to

connect to the web-based utility.

To resolve difficulties accessing a web utility, please follow the steps below.

Step 1 Verify physical connectivity by checking for solid link lights on the device. If
you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light may not be
on.

What type of cable should | be using?

The following connections require a Crossover Cable:
Computer to Computer

Computer to Uplink Port

Computer to Access Point

Computer to Print Server

Computer/’XBOX/PS2 to DWL-810
Computer/XBOX/PS2 to DWL-900AP+

Uplink Port to Uplink Port (hub/switch)

Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router

Computer to Normal Port (hub/switch)

Access Point to Normal Port (hub/switch)

Print Server to Normal Port (hub/switch)

Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
"If there is a link light, the cable is right.”
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

What type of cable should | be using? (continued)

What's the difference between a crossover cable and a straight-through
cable?

The wiring in crossover and straight-through cables are different. The two types
of cable have different purposes for different
LAN configurations. EIA/TIA 568A/568B

. .. 1 White-Green
define the wiring standards and allow for g gﬁ..tan o
two different wiring color codes as 1 Blue o l4e
illustrated in the following diagram. g ‘(-;‘-:?;;flue
. . 7 White-Brown
*The wires with colored backgrounds may 8 Brown

have white stripes and may be denoted 5684 CABLE END
that way in diagrams found elsewhere.

1 White-Orange
How to tell straight-through cable f 3 g
ow to tell straight-through cable from 3 White-Green
. 4 Blue
acrossover cable: _ 5 Whie.Blue
The main way to tell the difference 6 Green
R 7 White-Brown
between the two cable types is to compare 8 Brown

the wiring order on the ends of the cable. If
the wiring is the same on both sides, it is
straight-through cable. If one side has opposite wiring, it is a crossover cable.

5688 CABLE END

All you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:

A straight-through cable has identical ends

A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable is
important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer — Crossover

Computer to an normal port on a Hub/Switch — Straight-through

Computer to an uplink port on a Hub/Switch - Crossover

Hub/Switch uplink port to another Hub/Switch uplink port — Crossover

Hub/Switch uplink port to another Hub/Switch normal port - Straight-through
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 2 Disable any Internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

Bl Sousoty | Povany | Corserd | Cormmonons | Pragrems | ibvwand |

Step 3 Configure your Internet settings.

Go to Start>Settings>Control Panel. Double click Pyt e |

the Internet Options Icon. From the Security tab, i
click the button to restore the settings to their T e
defaults. 4
e e ot
o e
I S 1=
Gorml| Socunty | Fivacy | Cortert Corrwcionn | P | dvarced]
;1 [1 o il
Click the Connection tab and set the dial-up “r_—“““”* |
option to Never Dial a Connection. Click RN —
the LAN Settings button. %
e

r
Ll e b LA

e
LAH Satrgn ek kb et oo L S
heuts S s e e _TJ

O S i~ |

At conigaston.
Auskomatic corkgusation may ey murl Tommoun e
wswm?&hmwﬂ\ .

Nothing should be checked. Click OK. e

T Giip o VP corraciors

Go to the Advanced tab and click the
button to restore these settings to their

defaults.

Click OK. Go to the desktop and close any open
windows.




Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the
same range of the device you are attempting to configure. Most D-Link devices use
the 192.168.0.X range.

How can | find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the window as shown
then click OK.
Run 2]

Tupe the name of & program, folder, or document, and
windows will open it for yo.

Open: |winipcfg j

ok i Cancel | Browse... I

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

B Select your adapter from the drop down menu.

M If you do not see your adapter in the drop down menu, your adapter is
not properly installed.

IP Configuration =& K3

— Ethernet Adapter Infoimation

[PEF
Adapter Address [ |
Default Gateway
ok I EElease | EEmsw |

Feleaze Al | Renew All | Hore Info »> |

Step 4 After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.
Step 5 Click OK to close the IP Configuration window.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address
in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.

Step 2 Type cmd then click OK.
Run @ .-

~ Twpe the name of a program, folder, document, or
Internet resource, and Windows will open it Far wau.

Opern; :-cmci .-v

[ Ok H Cancel H Browse, .. ]

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway

S WINNT system32' CMD.EXE

Microsoft Windows 2BAA [Uersion E.ﬁ 21951
CC» Copyright 1985-28B@ Microsoft Corp.

D:~>ipconfig

Windows 2888 IP Configuration

Ethernet adapter Local Area Connection:
Connection—specific DNS Suffix

IP AQAPeSS. = . = » = » o « = « . ¢ 192.168.8.174
Subnet Mask T 255.255.255.8

Default Gateway - 192.168.8.1

Step 4 Type exit to close the command prompt.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP
Address in the same range of the device you are attempting to configure. Most D-Link
devices use the 192.168.0.X range.

Make sure you take note of your computer’s Default Gateway IP Address. The Default
Gateway is the IP Address of the D-Link router. By default, it should be 192.168.0.1.

How can | assign a Static IP Address in Windows XP?

Step 1
Click on Start > Control Panel > Network and Internet Connections >
Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.
How can | assign a Static IP Address in Windows 20007

Step 1 Right-click on My Network Do Gh tor fowte Do s 1
. - + - G| Phsewch rades 3 A W K | OF
Places and select Properties. .t...,u,.m“mm.mm
LU IS
Step 2 Right-click on the Local Network and Diskup <reccn <o
Area Connection which represents -
your network card and select
Properties.
21
Connect using:
I D-Link DFE-530T PCI Fast Ethernet Adapter
LConfig:
Companents checked are used by this connection:
Highlight Internet Protocol (TCP/ ;";;gf'kﬁjg:;jgfg bzt 2]
IP) and click Properties. TR -
Install Urinstall | Froperies |
i~ Description
n Contral Pratocol/Antemet Pratocol. The default
etwark protocol that provides commurication
terconnected networks.
[¥ Shaw icon in taskbar when connected
oK Cancel

70



Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows 20007?

(continued)

Click Use the following IP Address and g rErETE— 2%
enter an IP Address that is on the same General
subnet as the LAN IP Address on your e e e e e
router. Example: If the router’s LAN IP e P
Address is 192.168.0.1, make your IP € Detain an P adefess autamalialy
Address 192.168.0.X where X = 2-99. i
Make sure that the number you choose is e [5% = 2% 0
not in use on the network. Defaul gatoway: [T e 0 1

£ Obtain DNS server address automatically
Set the Default Gateway to be the @ Uttt ew e
same as the LAN IP Address of your itftdg:z W
router (192.168.0.1). —
Set the Primary DNS to be the same as o

the LAN IP address of your router
(192.168.0.1).

The Secondary DNS is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want to reboot your computer. Click

Yes.
How can | assign a Static IP i
Address in Windows 98/Me? St ]| A o |

The following network components are installed

Client for Microsoft Networks
D Link DFE 5307+ PCI Fast Ethemet Adapter (Fev 4]

Step 1 From the desktop, right-click on the
Network Neigborhood icon (Win ME - My

Network Places) and select Properties.

tdd. | Pemove | Fuoperies |
PFrimary Network Logon;
Highlight TCP/IP and click the Properties [0ttt etk =
button. If you have more than 1 adapter, _ Beenaiishang._|
then there will be a TCP/IP “Binding” for TEPAP1 o prooce o s comact 0 o et

wide-area networks.

each adapter. Highlight TCP/IP > (your

network adapter) and then click
Properties. Caree
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows

98/Me? (continued)

Step 2 Click Specify an IP Address.

Enter in an IP Address that is on the same
subnet as the LAN IP Address on your router.
Example: If the router’s LAN IP Address is
192.168.0.1, make your IP Address
192.168.0.X where X is between 2-99. Make
sure that the number you choose is not in
use on the network.

Step 3 Click on the Gateway tab.

Enter the LAN IP Address of your router
here (192.168.0.1).

Click Add when finished.

Step 4 Click on the DNS Configuration tab.

Click Enable DNS. Type in a Host (can be
any word). Under DNS server search order,
enter the LAN IP Address of your router
(192.168.0.1). Click Add.

Step 5 Click OK twice.
When prompted to reboot your computer,

click Yes.

After you reboot, the computer will now have
a static, private IP Address.

Step 5 Access the web management. Open your web
browser and enter the IP Address of your D-Link device in
the address bar. This should open the login page for the web

Braegs | Advweed | wemos |
DS Configuration | Gateway | WINE Conbguaaion 1P dchens

e o . .
1 in rwstonia. s vl smitcamatic oy rciagn P bchmsems, sk
the 1pace below,

€ Qbisin an P addbers auomaticaly
ety mE akiess]

1P Ackbess: 192.166. 0 .10
SybeetMak: [ 255.255.255. 1

oK I Cancel

Bndrgs | Advenced | Remins |
DNS Configuraion G8iewsy: | WINS Conbusstion | P Addvess

The adde

mechines we uzed.

Hew gateway
[t 0. 1] o

Inztabed gatewayr:
EBEIE Homeve
T
[10eAP Popeties —__EE]|
Bradngs Advrced | HebiDs
M5 Conapanton | Giatmessny | WINS Configpantion | 1P Ardiess
€ Disable DHS
= Erablo NS
Host [y Ogenae |
DINS Server
|
e =

|

S - |

management. Follow instructions to login and complete the configuration.
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?

Dynamic Cable connection
(i.e. AT&T-BI, Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast)

Note: Please configure the router with the computer that was last connected directly
to the cable modem.

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and

the password is blank (nothing). 20
'j:§> Flearte type your uzer name and passward.

Step 2 Click the Home tab and click the Y e 15216801

WAN button. Dynamic IP Address is the Reskn  DIE24

default value, however, if Dynamic IP Address UserName  [sdmn

is not selected as the WAN type, select Pasword |

Dynamic IP Address by clicking on the radio ™ Save tis passord n your password e

button. Click Clone Mac Address. Click on Carcel |

Apply and then Continue to save the

changes.

-AirPlus
MorenmE
High-Speed 2.4GHz Wireless Router

DI-624 I

Home Advanced Tools Status Help

Please selecd the appropriata opSon o connect bo your IEP.

Wizard o

& Dynamic (P Adgress Choose this oplion o oblain an IP address aulomaticalby from
your ISP, (Far most Cable modem users)

" Wireless  Stalic IP Address Choose this oplion 1§81 SEatic P infarmaton provided toyou

b your ISP

 PPEOE Chooze this option ifyour |SF uses FPPOE. (For most DEL
wEers)

© Cihers FFTF and BigPond Cable

{far Europe use only)

Ay

© PPTP
Hosl Name |D|-62-1 {oplionaly
MAC Address [0 oo .Jcs -3 [0 .[0D toptionan

Clona MAL Address I
2 90

Apply Cancel Help
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?
(continued)

Step 3 Power cycle the cable modem and router:

Turn the cable modem off (first) . Turn the router off Leave them off for 2 minutes.**
Turn the cable modem on (first). Wait until you get a solid cable light on the cable
modem. Turn the router on. Wait 30 seconds.

** If you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.

Step 4 Follow step 1 again and log back into the web configuration. Click the Status
tab and click the Device Info button. If you do not already have a public IP Address

under the WAN heading, click on the DHCP Renew and Continue buttons.

Static Cable Connection

Step 1 Log into the web based configuration by
typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The

username is admin (all lowercase) and the password R Ol
. . jsecName [odn
is blank (nothing). - —_—

™ Save this password in your pazsword kit
Step 2 Click the Home tab and click the WAN Cancel
button. Select Static IP Address and enter your
static settings obtained from
the ISP in the fields provided.

i S|

{j.) Please lype your user name and pazsword.
Y s 15216801

Q,:Lll}“_kw -idﬂi Pﬁ lus G-

If you do not know your = High-Speed 2.4GHz Wireless Router
settings, you must contact gl MO Advanced  Toole  Status  Help |
yOU r | S P . ;m. age seloct the appropriato opson 1o carmect 16 your ISP

 Dymarnic I Address Chaose this opon 1o abdain an IP address sutomatically fam

your ISP, (For most Cable modem users)

& Siatic IP Address nc';llva‘:'o“srelslr;s opon to 261 static IP infosrmation provided b you

step 3 CI |Ck on Apply and © PPFOE uc:eo';ie this option if your ISP uses PPPOE. (For mestDSL
X y © Others PPTP and BigPond Catile
then click Continue to save o rore torEuiope use or
the changes. prm—
i P Address 852120 (azsigred by your 1SF)

Step 4 Click the Status tab oncr— [ (R L
and click the Device Info BTy eS| E—
b utton . You r I P Add ress Secondary DNS Address 0.0.0.0 (optinal)
information will be displayed 2 OO
under the WAN heading. Aovly. Cancel Help
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection?

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet
300 from your computer or you will not be able to connect to the Internet.

Step 1 Upgrade Firmware if needed.

(Please visit the D-Link tech support website at: http://support.dlink.com for the latest
firmware upgrade information.)

Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip
and hold down the reset button on the back of the unit for 10 seconds. Release it and
the router will recycle, the lights will blink, and then stabilize.

Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into the
address window and hit the Enter key. When the password dialog box appears, enter
the username admin and leave the password blank. Click OK.

If the password dialog box does not come up repeat Step 2.
Note: Do not run Wizard.
Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoE.

Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP
Address).

Step 6 In the username field enter ELN/username@earthlink.net and your
password, where username is your own username.

For SBC Global users, enter username@sbcglobal.net.
For Ameritech users, enter username@ameritech.net.
For BellSouth users, enter username@bellsouth.net.

For Mindspring users, enter username@mindspring.com.
For most other ISPs, enter username.

Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless
specified by your ISP, and set Autoreconnect to Enabled.

Note: If you experience problems accessing certain websites and/or email issues,

please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for
more information and the proper MTU setting for your connection.
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection? (continued)

Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes,
unplug the power to the D-Link router.

Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem
has established a link to your ISP, plug the power back into the D-Link router. Wait
about 30 seconds and log back into the router.

Step 10 Click on the Status tab in the web configuration where you can view the
device info. Under WAN, click Connect. Click Continue when prompted. You should
now see that the device info will show an IP Address, verifying that the device has
connected to a server and has been assigned an IP Address.

Can | use my D-Link Broadband Router to share my Internet
connection provided by AOL DSL Plus?

In most cases yes. AOL DSL+ may use PPPoE for authentication bypassing the
client software. If this is the case, then our routers will work with this service. Please
contact AOL if you are not sure.

To set up your router:

Step 1 Log into the web-based configuration (192.168.0.1) and configure the WAN
side to use PPPoE.

Step 2 Enter your screen name followed by @aol.com for the user name. Enter your
AOL password in the password box.

Step 3 You will have to set the MTU to 1400. AOL DSL does not allow for anything
higher than 1400.

Step 4 Apply settings.

Step 5 Recycle the power to the modem for 1 minute and then recycle power to the
router. Allow 1 to 2 minutes to connect.

If you connect to the Internet with a different internet service provider and want to use
the AOL software, you can do that without configuring the router’s firewall settings.
You need to configure the AOL software to connect using TCP/IP.

Go to http://www.aol.com for more specific configuration information of their software.
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Frequently Asked Questions (continued)

How do | open ports on my router?

To allow traffic from the internet to enter your local network, you will need to open up
ports or the router will block the request.

Step 1 Open your web browser

and enter the |P AddreSS Of Wirtual Server is used to allow Internet users access to LAN services.
your D-Link router & Enabled © Disabled
(192.168.0.1). Enter username Name [pcanywharal Clear |
(admin) and your password Private P [1321680100
(blank by default). Protocal Type  [UDP =]

Private Port |22—
Step 2 Click on the Advanced Public Port [2

on top and then click Virtual Schecle  © Abays

Server on the left side. € From time [00 =] - [00 =] [0 =] 10 [00 =] - [on =] [ama =]

Step 3 Check Enabled to soyfSin Zrofsin 2
activate entry.

Step 4 Enter a name for your virtual server entry.

Step 5 Next to Private IP, enter the IP Address of the computer on your local
network that you want to allow the incoming service to.

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select
both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Enter the Schedule information.
Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer
and then open port 81 to the other computer.
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Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:

In computer networks, a DMZ (demilitarized zone) is a computer host or small
network inserted as a neutral zone between a company’s private network and the
outside public network. It prevents outside users from getting direct access to a
server that has company data. (The term comes from the geographic buffer zone that
was set up between North Korea and South Korea following the UN police action in
the early 1950s.) ADMZ is an optional and more secure approach to a firewall and
effectively acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or hostin
network terms) receives requests from users within the private network for access to
Web sites or other companies accessible on the public network. The DMZ host then
initiates sessions for these requests on the public network. However, the DMZ host is
not able to initiate a session back into the private network. It can only forward packets
that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company’s Web pages so these could be served to
the outside world. However, the DMZ provides access to no other company data. In
the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up

aDMZ.

How do | configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the local
network. The DMZ, or Demilitarized Zone, will allow the specified computer to be
exposed to the Internet. DMZ is useful when a certain application or game does not
work through the firewall. The computer that is configured for DMZ will be completely
vulnerable on the Internet, so it is suggested that you try opening ports from the
Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.
To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x

or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).
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Frequently Asked Questions (continued)

How do | configure the DMZ Host? (continued)

Step 2 Log into the web based configuration
of the router by typing in the IP Address of the
router (default:192.168.0.1) in your web
browser. The username is admin (all
lowercase) and the password is blank

(nOthing) Access Paint
User narme: g admin -

()

Password:

[CIremember my password

[ OK H Cancel ‘

Step 3 Click the Advanced tab and then click on the DMZ button. Select Enable
and type in the IP Address you found in step 1.

D-Link “AirPlus

Bullding Networks for People x7ﬂEMEGm
High-Speed 2.4GHz Wireless Router
; DI-624
Step 4 Click Apply | " home I Toole Sows  hep

and then Continue to
save the changes.

DMZ (Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to

SR the Internet

Virtuel Server
© Enabled @ Disabled

Note: When DMZ is P Addess 192 188,00
enabled, Virtual Server
settings will still be — P
effective. Remember, — 2 90
you cannot forward the e
same port to multiple

IP Addresses, so the
Virtual Server settings

will take priority over Performance
DMZ settings.

* Applications

Apply Cancel Help

[l [0
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Frequently Asked Questions (continued)

How do | open a range of ports on my DI-624 using Firewall rules?

Step 1 Access the router’s web configuration by entering the router’s IP Address in
your web browser. The default IP Address is 192.168.0.1. Login using your password.
The default username is “admin” and the password is blank.

If you are having difficulty accessing web management, please see the first question
in this section.

Step 2 From the web management Home page, click the Advanced tab then click
the Firewall button.

Step 3 Clickon D-Link “AirPlus =

Enabled and type in Xrremels

aname for the new High-Speed 2.4GHz Wireless Router
DI-624 .

rule. || SN advanced TSTERCTIRMNTY

step 4 Choose WAN Flrént;a\\ R;.;I.es can be used to allow or deny traffic from passing through the DI-624

as the Source and g € Enatiad C Dissbied

Mame Clear
Applications Action @ Allow © Deny
Interface IP Range Stat IP Range End Protocal Port Range

enter arange of IP
Addresses out on the

i E

internet that you — soce [ |
would like this rule R L ml” | e @l -

. chedule ways
applied to. If you Firewall  From time 73] - [302] [ =] o[G0 - [0 2] [ =]
would like this rule to way [5on =] o [Sum =]
allow all internet oMz ® 90
users to be able to A‘ct\un Namt.a Source  Destination e CF":;‘;?UIHQID
access these ports, 7 Allow  Allowto Ping WAN port WANS LAN1S2182040  loMPg 4
then put an Asterisk ol ol s B8 i

in the first box and
leave the second box

empty.

Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work

with a range of IP Addresses.

Step 6 Enter the port or range of ports that are required to be open for the incoming
service.

Step 7 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer

and then open port 81 to the other computer. 80




Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an FTP
Server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and a VPN
server at 192.168.0.7, then you need to specify the following virtual server mapping

table:
serverport | serverip [ Enable

21 192.168.0.5 X
80 192.168.0.6 X
1723 192.168.0.7 X

How do | use PC Anywhere with my DI-624 router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.
Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).

Step 2 Click on Advanced at the top and then click Virtual Server on the left side.

Step 3 Enter the
information as seen
below. The Private IP

is the IP Address of the
computer on your local
network that you want to
connect to.

Step 4 Thefirstentry
will read as shown here:

Step 5 Click Apply

and then click Continue.

Virtual Server
Yirtual Server is used to allow Internet users access to LAN services.

& Enabled € Disabled

Mame [pcanywhere M
Private IP IW
Protocol Type ITP;,
Private Part |22—
Public Port 22
Schedule & Always
€ From time [00 x| - [00 7| [AM > o [00 =] - [00 7| [AM =]
day [Sun =] to[Sun =]
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Frequently Asked Questions (continued)

How do | use PC Anywhere with my DI-624 router? (continued)

Step 6 Create
a second entry Wittual Server is used to allow Intermet users access to LAN semvices.

as shown here: & Enabled © Disabled

Marne Ipu:anywherez Clear |
Private IP I192.'|EB.D.'I 0o

Pratocal Type ITCP vl
Private Port |5531

. Public Port |5531
Step 7 Click
Apply and then Schedule & Always
click Continue. C From time |00 x| - [00 =] [AM =] ta [00 =] - 00 =] [AM ¥
daylSUﬂ 'l mISun 'I
Step 8 Create _ _ _
a third and final irtual Server is used to allow Internet users access to LAN services.
entry as shown

& Enabled O Disabled

Marng |pcanywher93 Clear |
Private IP I192.1EB.D.1 a0

Pratacal Type Im
Private Port W
Public Port  [BR3z
Schedule & Always
 From timeluuj : IUUj IAMj TDIDDj ;|Dﬂj I’Wj
day m to m

here:

Step 9 Click Apply and then click Continue.

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the
router, not your computer’s IP Address. 82



Frequently Asked Questions (continued)

How can | use eDonkey behind my D-Link Router?

You must open ports on your router to allow incoming traffic while using eDonkey.

eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server

4662 (TCP) To connect with other clients

4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the

Java Interface) with the client.

Step 1 Open your web browser and enter the IP Address of your router
(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.

Step 3 Create a
new firewall rule:

i AirPlus 5
Click Enabled. )GMG

Enter a name High-Speed 2.4GHz Wireless Router

2 90
Apply Cancel Help

Action Name Sgurce Destination Pratocol

select LAN under
interface. Enter

(edonkey). DL624 |
Click Allow. % |__Home IV VTTVRN Tools  Status _ Help |
NeXt to Source’ Firewall Rules can be used 10 allow or deny trafic fram passing through the DEE24
seIeCt WAN & Enabled T Disabled
under interface. In e [y [
the fIrSt bOX, Applicatsons Action = Aigw © Deny
enter an * Leave Interface IF Range Start P Range Erd  Protocol Pod Range
§ Sowca |NA.N;I|‘ |
—
the second box P s T — - |
empty. Schedule  © Always
Next to I Firewall € Fram time [00 2] - [00.=] A =] 1 [00 =] - o0 =] [ =
Destination, day [Sun 2] 1o [Bum =]
—_—
p—

the IP Address of Performancs F Allgw  llow o Fing WAN pad WAN® LAM19216801  ICMPE |4
F Dory  Defaull LAN" 1P,

the CompUter you F allow  Defaull Lam®s  *F 1P .°

are running

eDonkey from.

Leave the second

box empty. Under Protocol, select *. In the port range boxes, enter 4661 in the first
box and then 4665 in the second box. Click Always or set a schedule.

Step 4 Click Apply and then Continue.
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Frequently Asked Questions (continued)

How do | set up my router for SOCOM on my Playstation 2?7

To allow you to play SOCOM and hear audio, you must download the latest firmware

for the router (if needed), enable Game Mode, and open port 6869 to the IP Address of
your Playstation.

Step 1 Upgrade firmware (follow link above).

Step 2 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter username (admin) and your password (blank by default).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue.

D-Link A
Building mo}slf}nm A”'xp7'lﬂt...5§45 G"’

High-Speed 2.4GHz Wireless Router

DI-624 : >
l [ Home WYL IR Tools Status Help

&

Virtual Server

Yittual Server is used to allow Internet users access to LAN semvices.

@® Enabled © Disabled

Narne ['socom Clar |
Applications Private |P 192.168.0.100
Protocal Type  |Both =

-
Filters Private Port 6869
Public Port 6869
Firewall Schedule ® Always
© From time |00 x| : {00 =] [AM =] to {00 =] . [00 =] |Am =
1 DMZ day |Bun ¥ to|Sun
’
[ @ 90
Performance ) <
tual Servers List Apply Cancel Help
Marme Private [P Protocal Schedule
7 Vittual Server FTP 0.000 TCP 21421 ahways ]
I Virtual Serer HTTP 0.000 TCP 80/0 ahways 2]
7 Vitual Server HTTPS 0.00.0 TCP 4437443 atways Eii|
[T Virtual Server DNS 0.00.0 UDP 53/53 ahways B

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply
and then Continue. 84



Frequently Asked Questions (continued)

How can | use Gamespy behind my D-Link router?

Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter admin for the username and your password (blank by default).

Step 2 Click on the Advanced tab and then click Virtual Server on the left side.
Step 3 You will create 2 entries.

Step 4 Click Enabled and enter
Settings:

NAME - Gamespy1

W —AirPlus — .
Xoren=
High-Speed 2.4GHz Wireless Router

'": l T Advanced
PRIVATE IP - The |P \c"ﬂw“Sc‘nar I8 whed 16 allow Inlemat usars access 16 LAN sonices
Address of your computer DEGOB

that you are running
Gamespy from.

PROTOCOL TYPE - Both
PRIVATE PORT - 3783

Appiicatian:

Fittors.

iy

192.168.0.100

[3783

[78s

» Abways

£ From tene [005] - [00°2] [A4 5] 10 [00 5] - [0 =] A =]
tay [Sun =] 1o [Sen =]

2 0O

PUBLIC PORT - 3783 i Aoply Cancet Holp
Name Private 1P Protocol Schadule

I irual Serves FTR ooong TCP 2121 atways Lad5g

SCHEDULE _A|Ways_ B . 0000 TGP EIRD swaye [

T Viusl Serves HTTPS 0000 TCP 443443 ahuys 49

7 Vilusl Sereis DNS 0800 UDPS53S3 sheays 4

Click Apply and then continue.

Step 5 Enter 2nd entry:
Click Enabled orezs |

ST Advanced [T Status Help

it stians

NAM E - Ga m espy2 ‘ - \M‘ul .Sc.nar 5 weed 19 allow Intemat usars access 12 LAN sonices
P R IVATE I P Th I P ‘E ® Engbled © Dreabled 4
= e MHame gamespy2 Cliae

Address of your computer

192.168.0.100

Pratecol Type  [Both =

that youare running e
Gamespy from. e S
PROTOCOL TYPE - Both v P o W

PRIVATE PORT - 6500 a2
PUBLIC PORT - 6500 o wan B
: 0oog TCP 443043 whways 49
I Virnusl Seres DNS oaoon UDP 5353 ahways Pt i

SCHEDULE - Always.
Click Apply and then continue.



Frequently Asked Questions (continued)

How do | configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the KazaA
software. If you are having problems, please follow steps below:

Step 1 Enter the IP Address of your router in a web browser (192.168.0.1).
Step 2 Enter your username (admin) and your password (blank by default).
Step 3 Click on Advanced and then click Virtual Server.

Step 4 Click Enabled and then enter a Name (KaZaA for example).

Step 5 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 6 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

“home BTV Tools  Status  Helo

Winual Server is used to allow Interned users access to LAN seraces

= Enabled T Digabled
Nama |kuzua Clear

Private IP 192 168.0.100
Protocol Type |TCF TI
Preate Por 1214

Fublic Part IW
Schedule F Always
& From time [00.2] - [002] [AM =] 1o [002] - [00 2] [ =]
say 5 = oS ]

Make sure that you did not enable proxy/firewall in the KaZaA software.
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Frequently Asked Questions (continued)

How do | configure my router to play Warcraft 3?

You must open ports on your router to allow incoming traffic while hosting a game in
Warcraft 3. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112.

For the DI-604, DI-614+. DI-624,
DI-754, DI-764, or DI-774:

AirPlus =
rBlu G

Step 1 Open your web browser Hiahiene 2 U aksiomSaion

DI-624 |
and enter the IP Address of your (S
router (192.168.0.1). Enter I_""‘““““ | i
==y
——

. ® Ensbled T Disabled
username (admin) and your T a—rT1
password (leave blank). R
P G
i

® Abways

© From time [00 2] . [00 2] [AM =] 10 00 =] - [0 =] [Av =]

Step 2 Click on Advanced and
then click Virtual Server.

. 2 9O
Step 3 Create a new entry: Click oy Aoply Concl oo
Enabled. Enter a name Sose Teeaial gwere L
(warcraft3). Private IP - Enter the todn, Wit e BN

IP Address of the computer you

want to host the game. Select

Both for Protocol Type Enter 6112 for both Private Port and Public Port Click Always
or set a schedule.

Step 4 Click Apply and then Continue.

Note: If you want multiple computers from you LAN to play in the same game that
you are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you

should see Game Port. Enter the port number as you entered in the above steps.
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Frequently Asked Questions (continued)

How do | use NetMeeting with my D-Link Router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using (only) standard NAT and all internet sharing programs like
Microsoft ICS that use (only) standard NAT will NOT work with NetMeeting or other
H.323 software packages.

The solution is to put the router in DMZ.

Note: Afew hardware manufacturers have taken it on themselves to actually provide
H.323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do | set up my router to use iChat? -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.
iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) To video conference with other clients.

Step 1 Open your web browser and enter the IP Address of your router
(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

(continued)

How do | set up my router to use iChat? -for Macintosh users-

Step 3 Create anew
firewall rule:

Click Enabled.
Enter a name
(ichat1).

Click Allow.
Next to Source,
select WAN under
interface.

In the first box,
enter an *.

Leave the second
box empty.

Next to
Destination,
select LAN under
interface.

Enter the IP
Address of the

D-Link

Eurlding Petwarks for People

Virtu! Sarver

———
Apelcations.

Fillers

311

DMZ

Performande

[

TAIF} 95 us i

High-Speed 2.4GHz Wireless Router

irewall Rules
Firewall Rudes can be used 1o allow or deny trafic from passing through the DEE24

® Ensbled © Disabled

ame ik Clear
Aetion & Aflgw © Deny

iedsce I Renge Start I Range End  Protocol Poel Range
Source |WN‘-Jj|‘ |

Destination [LaN =] [192. 1680000 [

[uor ke [
Schedide & Abways

© Froen time [00 =] . [08 =] [A0 =] o [00 =] . [00 =] [ =]
day [Sun =] g |Sun =
@ 00

witll Rules List Apply Caneed Help

Agtion Mame Source  Destination Protetol
F Allow  Allow to Fing WAN port WANT LANE2.163.01 Icmes 4
F Deny Default - [ 1P "
F Allow  Default [0 1P

computer you are running iChat from.

Leave the second box empty. Under Protocol, select UDP. In the port range boxes,
enter 5060 in the first box and leave the second box empty.
Click Always or set a schedule.

Step 4 Click Apply
and then Continue.

Step 5

Repeat steps 3 and 4
enter ichat2 and
open ports 16384-

16403 (UDP).

D-Link

Building Metworks for Peopls

DI-624 I

-
-
DMZ

-

Wirlual Server

Applicalions

Filters.

Performance

?Afr,pﬁ lus G-
High-Speed 2.4GHz Wireless Router

irewall Rules
Firgwall Rubes cam be used 10 allow of deny 1rafic from pasgeng thiough the DHE24

& Emabled T Digabied

Name ichat? Claar
Aglion & Allew © Deny

inierface IF Range Stan IF Range End  Protocol Fort Range
Source AN =] [ |

Destination [LAN =] [1az 1680100 |

|uoe =][1e38. . [1e4n
Schedles  F Abways

& Fioen time [00 =] - [00 =] [A8 =] 1 [00 =] - [00 =] [ani =
day [Sun =] 1o[Sun =
2 90

Apply Concel Help

Aclion  Mame Source  Destination PFrotocol
B Allsw Al 1o Pang Withl pont WANT LAMISZIEB00  cwPg |4
F Deny Defaull b LA ® 1P @
F Allew  Defaull T [N
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

For File Sharing:
Step 1 Click on
Advanced and then
Virtual Server.

~AirPlus =,
Xorrenmels

High-Speed 2.4GHz Wireless Router

Step 2 Check Enabled P lome TR e felp

to activate entry.

“irtual Server is used 1o allow internot usess access to LAN services.
Step 3 Enter a name for & Enablod © Disabiod
; Horne Frr——
yoEr Vértual server entry —— - [m:‘sw
<IC at ) Frotocol Type  [TCF =
Filters Private Port S190
Step 4 Next to Private PuicPon 5180

IP, enter the IP Address Firewall Sthetule & aways
of the computer on your © From sime [103] [00 5] [A4 =] o [00 ] [0 2] [ 2]

)

day|Sun =] 4o | Sun '-I
local network that you !
W L
want to allow the e 9 O
Incoming service to. Apply Cancel Help
Mame Private IP Protocol Schedule
I Vietusl Seever FTR o000 TER 2121 always IE) |
Step 5 Select TCP fOI" T Vietusl Sesver HTTP 0000 TCP 8080 abways IE) |

Protocol Type.
Step 6 Enter 5190 next to Private Port and Public Port.
Stsp 7 Click Always or configure a schedule.

Step 8 Click Apply and then Continue.

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.

To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose Other from the Port Name pop-up menu.

Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV.

Step 8 Click OK.
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Frequently Asked Questions (continued)

How do | send or receive a file via iChat when the Mac OSX firewall
is active? -for Macintosh users- Mac OS X 10.2 and later

The following information is from the online Macintosh AppleCare knowledge base:

“iChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X firewall,
the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may keep
the firewall on if the AIM port is open. To open the AIM port:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.
Step 3 Click the Firewall tab.
Step 4 Click New.

Step 5 Choose AOL IM from the Port Name pop-up menu. The number 5190
should already be filled in for you.

Step 6 Click OK.

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X are
outlined in technical document 106461, "Mac OS X: File Sharing" in the AppleCare Knowl-
edge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click the

Firewall tab and select the service you have chosen in the "Allow" list. If you do not do
this, the firewall will also block the file sharing service. *
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Frequently Asked Questions (continued)

What is NAT?

NAT stands for Network Address Translator. It is proposed and described in RFC-
1631 and is used for solving the IP Address depletion problem. Basically, each NAT
box has a table consisting of pairs of local IP Addresses and globally unique
addresses, by which the box can “translate” the local IP Addresses to global address
and vice versa. Simply put, it is a method of connecting multiple computers to the
Internet (or any other IP network) using one IP Address.

D-Link’s broadband routers (ie: DI-604) support NAT. With proper configuration,
multiple users can access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.fags.org/rfcs/rfc1631.html
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Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and
within Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our web
site, or by phone.

Tech Support for customers within the United States:

D-Link Technical Support over the Telephone:
(877)453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:

D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 7:30am to 12:00am EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:
* Serial number of the unit
» Model number or product name

» Software type and version number
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Warranty
(USA only)

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

. D-Link or its authorized reseller or distributor and

. Products purchased and delivered within the fifty states of the United States, the District of
Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an
APO or FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described
below will be free from material defects in workmanship and materials from the date of original retail
purchase of the product, for the period set forth below applicable to the product type (“Warranty
Period”), except as otherwise stated herein.

1-Year Limited Warranty for the Product(s) is defined as follows:

. Hardware (excluding power supplies and fans) One (1) Year
. Power Supplies and Fans One (1) Year
. Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period
at no charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will
be rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be
new or have an identical make, model or part. D-Link may in its sole discretion replace the defective
Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is
substantially equivalent (or superior) in all material respects to the defective Hardware. Repaired or
replacement Hardware will be warranted for the remainder of the original Warranty Period from the date
of original retail purchase. If a material defect is incapable of correction, or if D-Link determines in its sole
discretion that it is not practical to repair or replace the defective Hardware, the price paid by the original
purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the defective
Hardware. All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase price is
refunded, shall become the property of D-Link upon replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”)
will substantially conform to D-Link’s then current functional specifications for the Software, as set forth
in the applicable documentation, from the date of original retail purchase of the Software for a period of
ninety (90) days (“Warranty Period”), provided that the Software is properly installed on approved
hardware and operated as contemplated in its documentation. D-Link further warrants that, during the
Warranty Period, the magnetic media on which D-Link delivers the Software will be free of physical
defects. D-Link’s sole obligation shall be to replace the non-conforming Software (or defective media)
with software that substantially conforms to D-Link’s functional specifications for the Software or to
refund at D-Link’s sole discretion. Except as otherwise agreed by D-Link in writing, the replacement
Software is provided only to the original licensee, and is subject to the terms and conditions of the
license granted by D-Link for the Software. Software will be warranted for the remainder of the original
Warranty Period from the date or original retail purchase. If a material non-conformance is incapable of
correction, or if D-Link determines in its sole discretion that it is not practical to replace the non-
conforming Software, the price paid by the original licensee for the non-conforming Software will be
refunded by D-Link; provided that the non-conforming Software (and all copies thereof) is first returned
to D-Link. The license granted respecting any Software for which a refund is given automatically
terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software
of D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers,
or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case,
the product is being sold “As-Is” without any warranty whatsoever including, without limitation, the
Limited Warranty as described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its

return policy. In case the return policy period has expired and the product is within warranty, the
customer shall submit a claim to D-Link as outlined below:
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. The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm
the same.

. The original product owner must obtain a Return Material Authorization (“RMA”) number from
the Authorized D-Link Service Office and, if requested, provide written proof of purchase of
the product (such as a copy of the dated purchase invoice for the product) before the
warranty service is provided.

. After an RMA number is issued, the defective product must be packaged securely in the
original or other suitable shipping package to ensure that it will not be damaged in transit, and
the RMA number must be prominently marked on the outside of the package. Do not include any
manuals or accessories in the shipping package. D-Link will only replace the defective portion
of the Product and will not ship back any accessories.

. The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD”) is allowed. Products sent COD will either be rejected by D-Link or become the
property of D-Link. Products shall be fully insured by the customer and shipped to D-Link
Systems, Inc., 17595 Mt. Herrmann, Fountain Valley, CA 92708. D-Link will not be held
responsible for any packages that are lost in transit to D-Link. The repaired or replaced
packages will be shipped to the customer via UPS Ground or any common carrier selected by
D-Link, with shipping charges prepaid. Expedited shipping is available if shipping charges are
prepaid by the customer and upon request.

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product
that is not packaged and shipped in accordance with the foregoing requirements, or that is determined
by D-Link not to be defective or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced
or removed; Initial installation, installation and removal of the product for repair, and shipping costs;
Operational adjustments covered in the operating manual for the product, and normal maintenance;
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;
Any hardware, software, firmware or other products or services provided by anyone other than D-
Link; Products that have been purchased from inventory clearance or liquidation sales or other sales in
which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the
product. Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this
Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FORAPARTICULAR PURPOSE
AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED INANY TERRITORY
WHERE APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO
NINETY (90) DAYS. EXCEPTAS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED
HEREIN, THE ENTIRE RISKAS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS
WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE
UNDERANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY
FORANY LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER,
WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO,
DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER
FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-
LINK’S PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATACONTAINED IN, STORED ON,
ORINTEGRATED WITHANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING
FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, ORARISING OUT OF ANY
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEENADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THE SOLE REMEDY FORABREACH OF THE FOREGOING LIMITED WARRANTY IS
REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT. THE MAXIMUM
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LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES AND REMEDIES
ARE EXCLUSIVEAND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY

Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some
states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how
long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited
warranty provides specific legal rights and the product owner may also have other rights which vary
from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product may
be reproduced in any form or by any means or used to make any derivative such as translation,
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as
stipulated by the United States Copyright Act of 1976. Contents are subject to change without prior

notice. Copyright® 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communication. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following measures:

. Reorient or relocate the receiving antenna.

. Increase the separation between the equipment and receiver.

. Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

. Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local
D-Link office.
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Registration

[ Register your D-Link product online at http://support.dlink.com/register/ ]

(10/11/04)
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